Installation and Commissioning Guide
Contents

List of Figures ................................................................. ix

List of Tables ................................................................. xi

About ......................................................................... xiii 1

Getting Started ............................................................. 1

  1.1 When to Use This Guide .............................................. 1
  1.2 How to Use This Guide ............................................... 1
  1.3 Required Equipment .................................................. 2
  1.4 Required Software .................................................... 2
  1.5 Extracting Files ........................................................ 3
  1.6 Software Package Components ..................................... 3
  1.7 PC Firewall ............................................................. 4

2 Site Considerations .................................................... 7

  2.1 Selecting a Site ......................................................... 7
  2.2 Assembly ................................................................. 7
  2.3 Orientation .............................................................. 8
    2.3.1 Magnetic Variation ................................................ 8
    2.3.2 Sighting Antenna Azimuth ...................................... 9
    2.3.3 Elevation Offset .................................................. 9
Part Two: Web iSite ........................................ 39

8 Connecting with Web iSite ................................ 41
  8.1 Web iSite ........................................... 41
  8.2 IP Address .......................................... 41
  8.3 Restoring Factory Defaults ........................................ 42
    8.3.1 X1 Indoor/Outdoor .................................. 42
    8.3.2 X7 ................................................. 44
    8.3.3 e150 ................................................. 44
  8.4 Cold Start: X1 Outdoor .................................. 45

9 Loading Packages with Web iSite ...................... 47
  9.1 Logging In to Web iSite .................................. 47
  9.2 Loading the Package File .................................. 49

10 Loading Options Files with Web iSite .................. 53
  10.1 Options File ........................................... 53
  10.2 Downstream Template .................................... 56

11 Pointing the Antenna with Web iSite .................. 59
  11.1 Preparation ............................................. 59
  11.2 Initial Alignment ...................................... 59
    11.2.1 Calculating Look Angle ......................... 59
    11.2.2 Coarse Alignment ................................ 61
  11.3 Peak Indicators ...................................... 61
    11.3.1 PWM .................................................. 61
    11.3.2 Graphic Display ................................... 62
  11.4 Peaking the Antenna .................................... 62

12 Over the Air Download .................................... 67
  12.1 Software Package and Options Push .................. 67
  12.2 Options File Only Push .................................. 69
  12.3 Verify the Download .................................... 69
Part Three: Commissioning ................................. 73

13 Setting Geo Location for Secure Mobiles ................. 75
  13.1 Secure Mobile Remotes .................................. 75
  13.2 Setting Geographic Location using the Console ........... 76
  13.3 Setting Geographic Location of an X7 ................... 76

14 Cross Polarization ........................................ 79
  14.1 Overview .................................................. 79
  14.2 Satellite Access ........................................... 81
    14.2.1 Preparation ........................................... 82
  14.3 Performing Cross-Pol Adjustment ......................... 82
  14.4 After Securing the Antenna .............................. 83

15 1 dB Compression Point and Maximum Power ............... 85
  15.1 Preparation ............................................... 85
  15.2 Determining the 1 dB Compression Point ................. 87
  15.3 Optional Procedure to Determine PN Max Power .......... 88

16 Acquiring the Network ..................................... 91
  16.1 Initial Acquisition: Overview ........................... 91
  16.2 Initial Acquisition ........................................ 92
  16.3 Front-Panel LEDs ......................................... 94
    16.3.1 Evolution e8350 .................................... 94
    16.3.2 Evolution X3 and X5 ................................. 95
    16.3.3 Evolution X1 .......................................... 96
    16.3.4 Evolution X7 .......................................... 97

17 Setting Power .............................................. 99
  17.1 Overview .................................................. 99
    17.1.1 The Reference Carrier ............................... 99
    17.1.2 Maximum Power ...................................... 100
  17.2 Setting Power ............................................ 101
    17.2.1 Setting TDMA Initial Power and Maximum Power ...... 101
    17.2.2 Setting SCPC Return Initial Power and Maximum Power 103
18 Post Acquisition Activities ........................................... 105

18.1 Network Operator Duties ........................................... 105

18.2 Remote Installer Duties ........................................... 105
  18.2.1 Recording Remote Status Using a Console Connection .................. 106
  18.2.2 Recording Remote Status Using Web iSite ............................. 107

18.3 Initiating Traffic Flow ............................................. 108

Appendix A: Loading Images with TFTP Server ....................... 109

Appendix B: Disabling the PWM Voltage in iBuilder .................. 111
List of Figures

Figure 1. Allowing iSite in Windows Firewall ........................................ 5
Figure 2. Example: Magnetic Declination ............................................... 8
Figure 3. Antenna Elevation Offset ...................................................... 10
Figure 4. Local Area Connection Status Dialog Box .............................. 14
Figure 5. Local Area Connection Properties Dialog Box ........................ 15
Figure 6. Internet Protocol (TCP/IP) Dialog Box ................................... 15
Figure 7. PuTTY Session Options Dialog Box ........................................ 17
Figure 8. PuTTY Configuration: Serial Parameters ................................. 18
Figure 9. Root Login and Linux Prompt ............................................... 19
Figure 10. Telnet and Login to iDirect Application .................................. 19
Figure 11. Entering the laninfo Command .......................................... 20
Figure 12. Welcome Screen and New Element Creation .......................... 22
Figure 13. Logging In to New Element ................................................. 22
Figure 14. Selecting the BSP File ....................................................... 24
Figure 15. Download Package Dialog Box Settings ................................. 25
Figure 16. Information Window: File Transfer Progress .......................... 25
Figure 17. Loading the Options File .................................................... 27
Figure 18. Open Dialog Box with Remote Options File Selected ............... 28
Figure 19. Resetting the Satellite Router After Download ...................... 28
Figure 20. ACC Key Example ............................................................ 30
Figure 21. iSite Antenna Pointing Dialog Box: Look Angle Calculator ....... 32
Figure 22. Starting Antenna Pointing .................................................. 35
Figure 23. Antenna Pointing Histogram and Current Signal Strength ....... 36
Figure 24. X1 Indoor Rear Panel: Reset Access Hole .............................. 42
Figure 25. X1 Outdoor Front Panel: Reset Button ................................. 43
Figure 26. Evolution X7 Reset Button: Location .................................... 44
Figure 27. Connecting to the Satellite Router using Web iSite ................. 47
Figure 28. Web iSite Login Page ....................................................... 48
Figure 29. Web iSite Dashboard Example: Evolution X7 ....................... 48
Figure 30. Web iSite File Management Page: Load Sections .................. 49
Figure 31. Selecting Package File ....................................................... 50
Figure 32. Load Package Status Box ................................................... 50
Figure 33. File Management: Load Options File .................................... 54
Figure 34. Load Options File Status Box .............................................. 54
Figure 35. Evolution X7 with Latest Software in Both Partitions ............... 55
Figure 36. Downstream Template: Example ........................................ 56
Figure 37. Web iSite Downstream Configuration Page ............................ 57
Figure 38. Restart Confirmation Box ................................................. 58
Figure 39. Web iSite Commissioning Dialog Box: Angle Calculator ............... 60
Figure 40. Web iSite Antenna Pointing Graphic Display: X7 .................... 63
Figure 41. Web iSite: Antenna Peak Indication .................................. 64
Figure 42. Web iSite: Confirming the Software Version .......................... 70
Figure 43. Web iSite: ODU Status .................................................. 70
Figure 44. View Options File: Frequency Translation ............................... 71
Figure 45. Setting Geographic Location: Evolution X7 .............................. 77
Figure 46. iSite Cross Polarization Dialog Box ..................................... 80
Figure 47. Web iSite Cross Polarization Page ........................................ 81
Figure 48. iSite: Specify Modulated Carrier Dialog Box .......................... 83
Figure 49. Sample Transfer Characteristic .......................................... 86
Figure 50. Adjusting Transmit Power using iSite and Web iSite .................. 87
Figure 51. iSite: Transmitting a Modulated Carrier ................................. 89
Figure 52. Web iSite: Transmitting a Modulated Carrier .......................... 89
Figure 53. iMonitor Probe: Changing the Satellite Router Transmit Power ...... 92
Figure 54. Initial Power in Probe and iBuilder ...................................... 100
Figure 55. iBuilder Transmit Properties: TDMA .................................. 101
Figure 56. Setting Modulated Maximum Power Custom Key ...................... 102
Figure 57. iBuilder Transmit Properties: SCPC Return ......................... 103
Figure 58. iBuilder Transmit Properties: SCPC Initial Power .................... 103
Figure 59. Remote Status Message .................................................. 106
Figure 60. Web iSite Modem Status Page .......................................... 107
Figure 61. iBuilder Remote Information Tab: Disabling Tx PWM ............... 111
List of Tables

Table 1. LAN Ports for Ethernet Cable Connections .......................... 16
Table 2. iDX Release 3.3 Remote Software Packages by Model Type ............ 23
Table 3. PWM Voltage Ranges and Signal Status ............................ 34
Table 4. Evolution X1 Outdoor Warm-Up Periods ............................ 45
Table 5. iDX Release 3.3 Remote Software Packages ........................... 49
Table 6. PWM Voltage Ranges and Signal Status ............................ 62
Table 7. iDirect Evolution e8350 LED Definitions ............................ 94
Table 8. iDirect Evolution X3 and X5 LED Definitions ......................... 95
Table 9. iDirect Evolution X1 LED Definitions ............................... 96
Table 10. iDirect Evolution X7 LED Definitions ............................... 97
About

Purpose

This document provides detailed instructions for installing and commissioning iDirect Evolution® Satellite Routers at remote sites. The guide supports the following models:

- Evolution X1, X3, X5, X7, e150, and e8350
- iConnex® e800, and e850

Note: iNFINITI® Satellite Routers are not supported in iDX Release 3.2 and later.

Intended Audience

This guide is written for satellite earth station engineers, network operators, and field technicians tasked with the installation and commissioning of iDirect Evolution Satellite Routers.

Contents Of This Guide

This document contains the following major sections:

- “Getting Started”
- “Site Considerations”
- “Part One: iSite”
- “Part Two: Web iSite”
- “Part Three: Commissioning”
- Appendix A, “Loading Images with TFTP Server”
- Appendix B, “Disabling the PWM Voltage in iBuilder”
1 Getting Started

This chapter describes how to use this guide, lists the tools required, and provides procedures for obtaining the software used to commission the Satellite Router.

This chapter includes the following sections:

- “When to Use This Guide” on page 1
- “How to Use This Guide” on page 1
- “Required Equipment” on page 2
- “Required Software” on page 2
- “Extracting Files” on page 3
- “Software Package Components” on page 3
- “PC Firewall” on page 4

1.1 When to Use This Guide

Use this guide when performing initial configuration and commissioning of an iDirect Evolution Satellite Router. Repeat the procedures if you move the Satellite Router from one fixed location to another.

1.2 How to Use This Guide

This guide documents the step-by-step procedures required to configure and commission the Satellite Router. The procedures appear in the order in which they are performed. Perform the steps in the sequence in which they are presented in the guide.

The document is divided into three parts. Part One describes use of the iVantage® Network Management System (NMS) iSite client software application. The iSite application is used when commissioning the Evolution X3, X5, e8350, and e8xx Satellite Routers.

Part Two describes the Web iSite interface, used when commissioning the Evolution X1, X7, and e150 Satellite Routers.

Part Three describes commissioning operations that are common to all remote sites and Satellite Router models. Where differences exist between iSite and Web iSite procedures, they are described in the affected sections.
1.3 Required Equipment

The following equipment is required to commission the Satellite Router in the field:

- A console cable with DB9 adapter or USB to RS-232 adapter. (Not required for Evolution X1, X7, or e150)
- A crossover Ethernet cable

*Note: In most cases, a straight-through Ethernet cable (rather than a crossover cable) can be used to connect to the Satellite Router. However, a straight-through cable may not work when connecting some PCs to Evolution X3, X5 or E8000 Series Satellite Routers.*

- A DC voltmeter with female “F” input adapter
- A hand-held GPS unit, or a map with geographic coordinates
- An indelible marker pen
- A PC or laptop with:
  - Windows 7, Windows XP, or Windows 2000 with Service Pack 3
  - A minimum of 512 MB RAM
  - A minimum processor speed of 1 GHz
  - A minimum of 50 MB of free disk space
  - Screen resolution of at least 1280 × 1024
  - Terminal emulator software (Not required for Evolution X1, X7, or e150)
  - A Web browser (Required for Evolution X1, X7, or e150 only)

1.4 Required Software

Installation and commissioning of Evolution X3, X5 and e8000 series satellite routers is performed using the iSite client, which must be installed on a local laptop or PC. Installation and commissioning of the Evolution X1, X7, and e150 Satellite Routers is performed using Web iSite. Web iSite is an embedded Web server that enables configuration and commissioning using a Web browser.

An “image file” containing remote software (and in some cases a Board Support Package file) must be installed on the Satellite Router. These files are distributed in a single .zip file and are usually installed locally using iSite or Web iSite. The installer can load the software locally or the Network Operator can transmit the remote software to the Satellite Router over the air when a Downstream Template has been loaded or downstream parameters have been manually configured on the Satellite Router.

The software packages may be downloaded from the iDirect Technical Assistance Center (TAC) at http://tac.idirect.net.

To download from the TAC Web site:

1. From the Home Page, under **Browse Items By Type**, click **Software Releases**.
2. Under **Within Software Releases**, click **iDX**.
3. Scroll down the list to iDX Release 3.3. A description of the selection appears below the hyperlinked headings. Click the link with “iSite” in the description.
5. Confirm that the correct release is displayed, then click Download.

In addition to the iSite application and image file packages, commissioning requires an options file or Downstream Template file to be installed on the Satellite Router during the commissioning process. Options files are created using the iVantage® NMS iBuilder application. Downstream Template files are created with a text editor. In either case, these files are provided to the installer by the Network Operator or Service Provider.

**Note:** The maximum transmit power in the initial options file loaded on the Satellite Router should be set to the highest allowable value. The initial transmit power should be set to the lowest allowable value. The configurable power range for X1 and e150 Satellite Routers is from -35 dBm to 0 dBm. The configurable power range for all other model types is from -35 dBm to +5 dBm.

### 1.5 Extracting Files

The iSite client software is distributed in a .zip file (Remote Packages and iSite iDX {release#}.zip) which includes the remote image packages and board support packages for all Satellite Routers.

To extract the files:

1. Copy the .zip file to a separate directory for extracting the compressed files. Store the files in a directory that is easy to locate later.
2. Extract the files with a .zip file utility application, or right-click the .zip file and select Extract All.
3. If desired, create a shortcut to iSite.exe on the desktop or in the Windows task bar. iSite.exe is located in the iSite folder.

The following folders are created when the compressed files are extracted:

    Remote Packages and iSite - iDX{release#}
    iSite/
    Images/
    Remote_Evolution_e8series
    Remote_Evolution_X3_X5
    Remote_Evolution_X1_e150
    Remote_Evolution_X7

where: {release#} is the iDX software version number.

### 1.6 Software Package Components

The iSite software and Satellite Router image files are bundled together in the downloaded .zip file, and appear in the unzipped folders. This includes:

- The NMS iSite program and support files (iSite folder)
- The Evolution e8000 Series BSP and remote image files (Remote_Evolution_e8series folder)
- The Evolution X3 and X5 BSP and remote image files (Remote_Evolution_X3_X5 folder)
1.7 PC Firewall

When using Windows XP and Windows 7 with iSite version 3.1 and above, it is necessary to disable or modify the Windows Firewall for full functionality of some features.

For Windows 7, because the Firewall may be selectively applied to separate domains, iDirect recommends that the Firewall remain enabled, but that the iSite application be granted access as an allowed application. Refer to Figure 1 for the following procedure:

To Configure Windows 7 Firewall for iSite:
1. Open the Control Panel and click Windows Firewall.
2. In the left-hand viewing pane, select Advanced Settings. A new window opens.
3. In the left-hand pane of the Windows Firewall with Advanced Security window, click Inbound Rules.
4. Scroll to iSite in the center viewing pane. Right-click and select Properties.
5. In the General tab under Action, select Allow the connection.
6. Click OK.
7. Repeat for other instances of iSite in the scroll-down list.
8. Close Firewall windows.
Figure 1. Allowing iSite in Windows Firewall
PC Firewall
2 Site Considerations

This chapter provides general guidelines and principles for the location, assembly, and orientation of the VSAT antenna that are applicable to all installation sites. Refer to the antenna manufacturer’s documentation for specific installation and operating instructions.

This chapter includes the following sections:
- “Selecting a Site” on page 7
- “Assembly” on page 7
- “Orientation” on page 8

2.1 Selecting a Site

A comprehensive site survey is beyond the scope of this guide. However, keep the following general guidelines in mind when selecting the site:
- Select a level surface that is approximately 10 feet by 10 feet.
- Avoid proximity to other transmitters.
- Avoid exposing others to incident radiation.
- Verify a clear line-of-sight to the satellite.
- Consider availability of electrical power and routing of cables (power, IFL, LAN).
- Verify that the coaxial IF cables (Tx, Rx) can reach the Satellite Router from the selected antenna location. RG-6 cable may be used up to a distance of 250 feet. If the run is longer, RG-11 cable must be used up to a maximum distance of 500 feet.
- Ensure that cables do not cross roads or foot-traffic areas.

2.2 Assembly

Assemble the antenna and mount by following the manufacturer’s assembly instructions. After installation, ensure that:
- The antenna base is fixed on a stable surface that will not shift.
- Ballast is installed on the antenna base (to combat wind).
- The mast pipe is plumb.
2.3 **Orientation**

The following section describes antenna orientation principles generally applicable to all site installations, illustrated with a typical VSAT antenna configuration. Magnetic variation and elevation offset principles are discussed in detail.

*Note: The antenna may not be identical to the antenna used in this example. See the antenna manufacturer’s instructions for specific information.*

### 2.3.1 Magnetic Variation

Magnetic variation (also referred to as “declination”) is the difference between the true heading referenced to the geographic North Pole, and the magnetic heading as registered on a magnetic compass. The magnitude and direction of magnetic variation differs depending upon the geographic location. Magnetic variation changes slowly with time.

Figure 2 illustrates magnetic variation in the United States. More detailed, up-to-date maps are available on the Internet, and must be consulted for the latest data.

*Figure 2. Example: Magnetic Declination*

Magnetic variation alters the reading of a magnetic compass with respect to true North. Maps and map display systems, including the output of the iDirect Look Angle Calculator, are referenced to true geographic North. Therefore a correction factor must be applied to readings taken by a magnetic compass to obtain the correct value, referred to as the true heading.

Magnetic variation is specified in degrees East or West of the agonic line (line of zero variation), shown as a red dotted line in Figure 2. As depicted in the figure, East declination...
causes the compass to be deflected to the right of the true heading, while West declination causes the compass needle to deflect to the left of the true heading. Consequently, add West declination, and subtract East declination, from the compass reading to obtain the true heading (Mnemonic: “West is Best, East is Least”).

For example, the illustration depicts the 10° West isogonic line passing through Baltimore, MD. In that location, 10 degrees must be added to the compass indication to obtain the true heading.

2.3.2 Sighting Antenna Azimuth

When sighting the antenna to determine azimuth, it is important to consider the effect of large metal objects nearby, which could influence the compass measurement.

Measure from behind the antenna, looking in the direction of the feed horn. Walk around behind the antenna and watch the compass to determine if the field is uniform or if anomalies exist.

Use an object in the far background as a target to align the compass. Sight along a line perpendicular to the plane of the reflector. The back plate of the reflector assembly can serve as a reference.

Add or subtract the declination in your location to the compass reading. This is the true heading of the antenna. When aligning the antenna to the value determined by the Look Angle Calculator, mark the position with a line drawn across the lower section of the azimuth mount and the pole using an indelible marker.

2.3.3 Elevation Offset

An offset antenna has the virtue of unobstructed antenna aperture, especially beneficial for VSAT terminals. Reflector optics are modified from a parabola, allowing the feed to be placed off the mechanical axis. The resulting beam (optical) axis is offset by an angle equal to the angle between the feed and the mechanical axis. See Figure 3.

A typical 1.8 meter antenna has a 22.6° offset, while a typical 1.2 meter antenna has a 17° offset. For example, the antenna reflector elevation required to achieve a beam angle of 50° relative to the horizon is calculated as follows for a 1.8 meter antenna:

\[50° - 22.6° = 27.4°\]

The reflector back plate is perpendicular to the mechanical axis of the antenna. When the back plate is vertical (90°), the beam elevation is 22.6°. To move the beam axis to the desired 50° elevation angle as in the example above, the antenna back plate is elevated from 90° to 117.4° (90 + 27.4) or, depending on the type of inclinometer used, a reading of 62.6° (90 - 27.4).

Always refer the original equipment manufacturer’s (OEM) installation instructions when installing the antenna and mount. Consult the OEM specifications to determine the offset angle for the particular antenna being installed.
Figure 3. Antenna Elevation Offset
The Satellite Router Installation and Commissioning Guide is divided into three parts. Part One describes the commissioning process when using the iVantage NMS iSite client. The iSite software is used when commissioning the Evolution X3, X5, e8350, and e8xx Satellite Routers.

See Part Two: Web iSite on page 39 when commissioning the Evolution X1, X7, and e150 Satellite Routers.

Part One contains the following chapters:

- Chapter 3, “Connecting to the LAN Port”
- Chapter 4, “Loading Packages with iSite”
- Chapter 5, “Loading Options Files with iSite”
- Chapter 6, “Configuring TRANSEC ACC Keys”
- Chapter 7, “Pointing the Antenna with iSite”
3 Connecting to the LAN Port

This chapter describes how to connect to the Satellite Router LAN port to prepare to configure and commission the router using iSite. This chapter also describes when and how to connect to the Satellite Router Console port to determine the IP address if necessary.

This chapter includes the following sections:

- “IP Address” on page 13
- “Local Area Connection” on page 14
- “Retrieving the IP Address using the Console Port” on page 17

Note: This chapter applies primarily to Evolution X3, X5 and e8000 Series Satellite Routers that are configured with iSite. However, the procedure in “Local Area Connection” on page 14 may also be useful on Evolution X1, X7 and e150 Satellite Routers if the Satellite Router’s IP address is known and DHCP is disabled on the Satellite Router. See “Connecting with Web iSite” on page 41 for details.

3.1 IP Address

The IP address and subnet mask of the Satellite Router are needed to configure the Local Area Connection. The local PC must be in the same subnet as the Satellite Router.

The Satellite Router factory default IP address is 192.168.0.1. The default subnet mask is 255.255.255.0. If the Satellite Router was previously used in a different network, the IP address and subnet mask may have changed.

If the IP address and subnet mask are unknown for an Evolution X3, X5 or e8000 Series Satellite Router, retrieve the IP configuration by accessing the iDirect Application software on the Satellite Router using the Console port. See “Retrieving the IP Address using the Console Port” on page 17 for details.

Once the IP address and subnet mask of the Satellite Router are known, proceed with the instructions in “Local Area Connection” on page 14 to configure the PC in the same IP subnet as the Satellite Router.
3.2 Local Area Connection

To connect using the LAN port, the local PC must be in the same subnet as the Satellite Router. This is done by modifying the TCP properties of the Local Area Connection on the local PC. The following section uses the Windows 7 operating system to illustrate the procedure.

To modify the Local Area Connection:

1. In Control Panel, click Network Sharing Center.
2. Double-click Local Area Connection to display the Status dialog box.

Figure 4. Local Area Connection Status Dialog Box
3. Click **Properties** to display the **Properties** dialog box.

![Local Area Connection Properties Dialog Box](image)

**Figure 5. Local Area Connection Properties Dialog Box**

4. Highlight **Internet Protocol Version 4 (TCP/IPv4)** as shown in **Figure 5**, and click **Properties**. The properties dialog box appears.

![Internet Protocol (TCP/IP) Dialog Box](image)

**Figure 6. Internet Protocol (TCP/IP) Dialog Box**
5. Select **Use the following IP address.** Type an IP address that is inside the range specified by the Satellite Router’s IP address and subnet mask. See Figure 6.

6. Click in the **Subnet mask** data entry field. The Windows 7 default value will appear automatically. If the Satellite Router subnet mask is known to be different, type in the correct values.

7. Type the Satellite Router IP address in the **Default Gateway** field.

8. For a local connection, DNS server addresses are not required. Leave the fields blank.

9. Click **OK** to save the changes.

The local connection is now configured to connect to the Satellite Router using iSite.

**To confirm connectivity:**

1. Confirm that power is applied to the Satellite Router.

2. Connect a crossover Ethernet cable between the LAN port of the local PC and the LAN port of the Satellite Router specified in Table 1,

**Table 1. LAN Ports for Ethernet Cable Connections**

<table>
<thead>
<tr>
<th>Satellite Router Model Type</th>
<th>LAN Port Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evolution e8350</td>
<td>LAN B</td>
</tr>
<tr>
<td>Evolution X3, X5</td>
<td>LAN A</td>
</tr>
<tr>
<td>Evolution X1</td>
<td>LAN</td>
</tr>
<tr>
<td>Evolution X7</td>
<td>LAN 1</td>
</tr>
</tbody>
</table>

3. Open the command prompt on the local PC.

4. Ping the Satellite Router by entering the following command: `ping <ip address>`

5. Verify that packets are returned without error.

The local PC is now configured to use iSite for communication over the LAN port. Continue to “Loading Packages with iSite” on page 21.
3.3 Retrieving the IP Address using the Console Port

Perform the procedures in the following sections to retrieve an unknown IP address and subnet mask.

3.3.1 Connecting to the Console Port

Any terminal emulator can be used to connect to the Satellite Router console. The following section uses PuTTY to illustrate the procedure. Once the IP address is known, telnet can be used to connect to the console port.

*Note:* Evolution X1 and e150 Satellite Routers do not have console ports.

One end of the console cable terminates in a DB-9 female connector. An appropriate adapter must be used (e.g., DB-9 male to USB, DB-9 male to RJ-45) to interface with the local PC.

To Connect Via the Console Port:

1. Connect the console cable (with adapter) to an available COM port of the local PC.
2. Plug the other end of the cable into the Console port of the Satellite Router.
3. Apply power to the Satellite Router.
4. Open PuTTY. Confirm that Session is selected in the left-hand Category window.

![PuTTY Session Options Dialog Box](image)

5. Under Basic Options→Connection Type, click Serial. Default or last-used values will appear in the Serial line and Speed fields. See Figure 7.
7. Refer to Figure 8. Edit the data fields as needed. The required parameters are:
   a. Speed (baud): 9600
   b. Data bits: 8
   c. Stop bits: 1
   d. Parity: None
   e. Flow control: XON/XOFF

8. Be sure to enter the correct available COM port number to be used for the session. If unsure, view Devices and Printers in the Windows Control Panel.

![PuTTY Configuration: Serial Parameters](image)

9. To start the serial connection session without saving it by name, click Open.

10. To save the session parameters for future use, return to Session→Basic Options and enter a name in the Saved Sessions field. Click Save, and then Open.

11. The PuTTY session starts in a new window.

   Note: If the Satellite Router is a mobile and the serial connection is lost, the console port baud rate will change to 4800 bps during the boot process. All other settings will remain the same. To re-establish communication with the console port, change the serial port speed to 4800 bps.
12. Press Enter to generate a response from the Satellite Router. If communication is 
established, the console prompt is displayed. If not, re-examine the settings to be 
sure they are correct.

![Figure 9. Root Login and Linux Prompt](image)

13. At the iDirect login prompt, enter `root`.
14. At the Password prompt, enter the default password `iDirect` (in some cases, 
the default password may be `P@55w0rd!`).

Successful login to the root-level Linux OS is indicated by the # prompt (Figure 9).

### 3.3.2 Logging In to the iDirect Application

To retrieve IP and subnet information from the Satellite Router, it is necessary to query 
the iDirect Application. Refer to Figure 10 for the following steps.

**To Log In:**

1. At the Linux prompt (#), enter `telnet localhost`.
2. At the Username prompt, enter, `admin`.
3. At the Password prompt, enter the default password, `iDirect`. (In some cases, 
the default password may be `P@55w0rd!`.)

![Figure 10. Telnet and Login to iDirect Application](image)

Successful login to the iDirect application is indicated the > prompt.
3.3.3 Retrieving the IP Address

After logging in to the iDirect Application program, retrieve the IP address and subnet mask.

To display the IP address and Subnet Mask:

1. At the command line prompt, enter `laninfo` (Figure 11).

![Figure 11. Entering the laninfo Command](image)

`laninfo` displays the current IP Address and net mask of the Satellite Router. In Figure 11, the IP address is 10.111.22.1, and the subnet mask is 255.255.255.0. Use this information to configure the local PC when connecting to the Satellite Router via the LAN port. See “Local Area Connection” on page 14.
4 Loading Packages with iSite

This chapter describes how to load the board support package (BSP) and remote image file on an Evolution X3, X5 or e8000 Series Satellite Router using iSite.

This chapter includes the following sections:
- “Logging In to iSite” on page 21
- “Loading BSP and Remote Images” on page 23

Note: This chapter does not apply to Evolution X1, X7, or e150 Satellite Routers. See “Connecting with Web iSite” on page 41 for details.

4.1 Logging In to iSite

Perform the steps in the following section to establish communication with the Satellite Router using iSite.

To Log In to iSite:

1. Confirm that the LAN port of the local PC is connected to the LAN port of the Satellite Router with a crossover LAN cable, and that power is applied to the Satellite Router.

2. Launch iSite with the shortcut created earlier, or by clicking iSite.exe in the iSite folder created during the unzip operation. The iSite welcome screen opens.

3. Create a logical remote in iSite by right-clicking the Globe icon (iDirect) in the iSite Tree View displayed in the left-hand viewing pane.

4. Click New to add an “unknown” element to the iSite Tree (Figure 12).

5. Right-click the new element and select Login to open the Login dialog box (Figure 13).


7. Enter the default administrator password, iDirect. In some cases the default admin password may be P@55w0rd!.

8. Under Login As, select Admin and Secure Connection. See Figure 13.

9. Click OK.

Upon successful login, the Remote configuration screen opens in the right-hand viewing pane.
Loading Packages with iSite

Figure 12. Welcome Screen and New Element Creation

Figure 13. Logging In to New Element
4.2 Loading BSP and Remote Images

After logging in to iSite, load the board support and remote image file packages on the Satellite Router.

For Evolution X3, X5 and e8000 Series Satellite Routers, two model-specific packages must be loaded: the Linux board support package (BSP), and the remote image package. Both packages must be loaded in order, starting with the BSP, followed by the remote image package.

For each model type supported in iDX Release 3.3, Table 2 identifies the folder name containing the packages and the contents of each folder for iDX Release 3.3. The Images folder is in the location on the local PC created during the unzip operation.

<table>
<thead>
<tr>
<th>Model</th>
<th>Location</th>
<th>Packages to Download</th>
</tr>
</thead>
<tbody>
<tr>
<td>X3, X5</td>
<td>/Images/Remote_Evolution_X3_X5</td>
<td>evo_x3_x5_bsp-15.0.0.0.bsp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>evo_x3_x5_rmt-15.0.0.0.pkg</td>
</tr>
<tr>
<td>e8000 Series</td>
<td>/Images/Remote_Evolution_e8series</td>
<td>evo_bsp-15.0.0.0.bsp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>e8_rmt-15.0.0.0.pkg</td>
</tr>
<tr>
<td>X1</td>
<td>/Images/Remote_Evolution_X1</td>
<td>evo_x1_indoor_rmt-15.0.0.0.pkg</td>
</tr>
<tr>
<td></td>
<td></td>
<td>evo_x1_outdoor_rmt-15.0.0.0.pkg</td>
</tr>
<tr>
<td>X7</td>
<td>/Images/Remote_Evolution_X7</td>
<td>evo_X7_rmt-15.0.0.0.pkg</td>
</tr>
<tr>
<td>e150</td>
<td>/Images/Remote_Evolution_e150</td>
<td>evo_e150_rmt-15.0.0.0.pkg</td>
</tr>
</tbody>
</table>

Note: See “Connecting with Web iSite” on page 41 for procedures to load Evolution X1, X7, and e150 software packages.

To Load the BSP File:
1. Right-click the Remote element in the iSite Tree View and select Download Package to open the Download Package dialog box.
2. Click the Open button to display the Open dialog box.
3. Navigate to the software package folders on the local PC.
4. In the Open dialog box, open the folder with the applicable Satellite Router model number in the folder name. Figure 14 illustrates an example when commissioning the X3.
5. Double-click the board support package (.bsp file) in the Open dialog box. The selected package file is displayed in the Download Package dialog box.
Loading Packages with iSite

6. In the **Download Package** dialog box (**Figure 15**), select the following options:
   - Don’t check versions
   - Download images only
   - Don’t reset
Note: For the following steps, additional (optional) confirmation of successful package loading is available by monitoring execution in a Console session. See “Connecting to the Console Port” on page 17.

7. Click Start. The Download Package Information window displays the progress of the file transfer and image flash. Wait until the word Done is displayed before proceeding.
When loading of the board support package is complete, perform the remaining steps in this section to load the remote image package on the Satellite Router.

To Load the Remote Image Package:

1. Click the **Open** button in the **Download Package** dialog box again, and navigate back to the remote packages on your laptop.

2. Double-click the applicable remote image package in the **Open** dialog box. The file has a `.pkg` file extension.

   **Note:** In folders containing files for more than one model, be sure to select the remote package applicable to the connected Satellite Router.

3. In the **Download Package** dialog box, select the following options, as before:
   - Don’t check versions
   - Download images only
   - Don’t reset

4. Click the **Start** button.

5. Wait while the file transfer progresses. Observe the **Information** section of the **Download Package** dialog box until the word **Done** is displayed.

After loading both software packages on the Satellite Router, continue to “Loading Options Files with iSite” on page 27.
5 Loading Options Files with iSite

This chapter describes how to load the options file on the X3, X5, and e8000 Series Satellite Routers using iSite.

This chapter includes the following section:

- “Options File” on page 27

Note: For Evolution X1, X7, or e150 Satellite Routers. See “Connecting with Web iSite” on page 41.

5.1 Options File

The remote options file contains specific site and network information such as operating frequencies, geo location, and other important parameters. Remote options files are generated in iBuilder, and must be loaded on the Satellite Router in order to acquire the network. Loading an options file is similar to loading a remote software package.

To Load The Options File:

1. In the iSite Tree View, right-click the Remote and select Download Option from Disk.

![Figure 17. Loading the Options File](image)
2. In the Open dialog box, navigate to the folder on the local PC containing the specific options file for the site.

![Open Dialog Box with Remote Options File Selected](image)

Figure 18. Open Dialog Box with Remote Options File Selected

3. Select the .opt file and click Open.

4. When iSite requests confirmation, click Yes. The Options File is loaded on the Satellite Router.

![Resetting the Satellite Router After Download](image)

Figure 19. Resetting the Satellite Router After Download

5. Click Reset Now.

Reset of the Satellite Router causes a forced logout from iSite. After the reset, the IP address of the Satellite Router changes to that specified in the Options File. The new IP address is determined in advance by the Network Service Provider or Network Operator.

The default password is also specified in the options file. If the Network Service Provider changed the Satellite Router password from the iDirect factory default, log in to the router using the new password.

After loading the options file, continue to “Pointing the Antenna with iSite” on page 31.
6 Configuring TRANSEC ACC Keys

This chapter describes how to configure the Satellite Router for operation with TRANSEC transmission security. Perform the procedures in this section only when commissioning the Satellite Router in a TRANSEC network.

This chapter includes the following sections:
- “Prerequisites” on page 29
- “Loading ACC Keys” on page 30

6.1 Prerequisites

Before a newly-commissioned remote can acquire a TRANSEC network, the following two conditions must be met:
- If an X.509 certificate has not yet been issued for the remote, then authentication must be disabled for the remote at the hub, and in the remote options file.
- The current Network Acquisition Keys (ACC Keys) must be resident on the Satellite Router.

6.1.1 Commissioning without an X.509 Certificate

If the Satellite Router is not yet certified for the TRANSEC network, authentication must be disabled in the options file loaded in the previous chapter. Follow the steps below only if the remote does not yet have an X.509 certificate:

To Disable Authentication:
1. Verify that the following parameter is set to 0 in the options file: auth_level_required = 0
2. If auth_level_required = 1, use a text editor to change it to 0, and save the file.
3. Load the modified options file on the Satellite Router.
4. Coordinate with the Network Operator to select Disable Authentication on the iBuilder Remote Information tab, and to apply the hub-side changes.

Authentication is now disabled on the Satellite Router, and at the hub.
6.2 Loading ACC Keys

If the current ACC Keys and pass phrase are not available, coordinate with the Network Operator to obtain them over a secure link. The procedure for retrieving the current ACC Keys from the hub is documented in the iDX iBuilder User Guide, available on the TAC Web site.

Sample ACC Keys are shown in Figure 20.

![Sample ACC Keys](image)

**Figure 20. ACC Key Example**

To Load the ACC Keys:

1. Open a terminal session to the Satellite Router and log in to the root account. (See “Connecting to the Console Port” on page 17 for details.)
2. Enter the command:
   ```
   telnet localhost
   ```
3. At the Username prompt, log in to the admin account.
4. At the command line prompt, enter the command: `csp enable`
5. Enter the command:
   ```
   keyroll_mgr setACCKey
   ```
6. A prompt appears for each of the three segments (lines) of the encrypted key and the pass phrase. Respond to each prompt with the requested information. You can type Q to quit at any time.
7. When asked to continue, enter:
   ```
   Yes
   ```

A message appears stating that the Network Acquisition Key has been updated.

After loading the ACC Keys, continue to “Pointing the Antenna with iSite” on page 31.
7 Pointing the Antenna with iSite

This chapter explains how to point the antenna using iSite.

This chapter includes the following sections:

• “Preparation” on page 31
• “Initial Alignment” on page 31
• “Peak Indicators” on page 33
• “Peaking the Antenna” on page 34

7.1 Preparation

The following procedure assumes that the BUC and LNB are in the operational state.

The following items are required for this procedure:

• DC Voltmeter
• 75Ω “F” female voltmeter input adapter

To Prepare for Pointing:

1. Disable Windows Firewall on the local PC. See “PC Firewall” on page 4.
2. If the Satellite Router is on, disconnect power.
3. Ensure that the Receive IF cable is connected from the LNB to the Satellite Router.
4. Ensure that the Transmit IF cable is connected to the Satellite Router TX Out port.
5. Disconnect the Transmit IF cable from the BUC and connect it to the voltmeter.
6. Reconnect power to the Satellite Router.

7.2 Initial Alignment

iSite provides a Look Angle Calculator to compute the initial azimuth, elevation, and polarity settings for the antenna. The initial settings provide a starting point from which to begin fine-pointing or ‘peaking’ of the antenna.

7.2.1 Calculating Look Angle

iSite calculates look angle based upon the geographic location data entered by the user. If the antenna site geographic coordinates are unknown, they may be determined with a GPS
receiver or a map. For the procedures that follow, log in to the Satellite Router as described in “Logging In to iSite” on page 21.

To Calculate Look Angle:

1. In the iSite Tree View, right-click the Remote and select Align Antenna → Antenna Pointing. Alternately, click the icon in the tool bar. The Antenna Pointing dialog box appears. See Figure 21.

![Antenna Pointing dialog box](image)

Figure 21. iSite Antenna Pointing Dialog Box: Look Angle Calculator

**Note:** If commissioning a mobile remote, some data entry fields will be blank. Enter the correct information for the site location.

2. In the Antenna Pointing dialog box, select the Look Angle Calculator tab.

3. Under Remote Location, enter the Latitude and Longitude of the antenna in decimal notation. Select degrees North or South of the equator, and degrees East or West of the Prime Meridian in the adjacent drop-down boxes.

4. In Spacecraft Position, the Longitude field is automatically populated. If not, enter the orbital position of the spacecraft in degrees East or West of the Prime Meridian.
5. In Elevation Information, enter the elevation Offset of the antenna. Refer to the antenna manufacturer’s specifications to confirm the offset angle.

After the required data is entered, iSite automatically calculates azimuth, elevation, and polarization angles and displays the data under Gross Antenna Pointing Information. When updating input fields, be sure to click anywhere in the gray area of the screen to re-calculate and display the output using the new data.

*Note:* Write the pointing values down, or leave the screen open. The data are needed in the following sections to perform pointing of the antenna.

### 7.2.2 Coarse Alignment

Use the data provided in the previous section to perform a coarse alignment of the antenna towards the satellite. The following items are required:

- Compass or GPS receiver
- Site magnetic variation data
- Inclinometer
- Indelible marker
- Hand tools as required

For the procedure that follows, it is not necessary to completely tighten the fixing hardware of the antenna axes. Satellite acquisition and fine pointing are performed later.

**To Perform Coarse Alignment:**

1. Determine the site magnetic variation, available on the Web. See “Magnetic Variation” on page 8.

2. Refer to the Notes area of the Look Angle Calculator. Using an inclinometer or protractor, adjust the feed horn assembly to the approximate angle indicated in the Polarization Offset field. See Figure 21.

3. Using an inclinometer, set the elevation to the value provided in the Elevation Actual field. Remember that this value is the true elevation minus the antenna offset angle.

4. Using a compass or GPS unit, set the antenna azimuth to the approximate heading indicated in the Azimuth True field. Be sure to apply the local magnetic variation to the compass reading. West variation must be added, and East variation must be subtracted from the value indicated by the compass. The result is the true azimuth.

5. Mark the coarse azimuth position with a line drawn across the lower section of the azimuth mount and the pole, using an indelible marker.

After completion of coarse alignment, execute the procedures in the sections that follow to peak the antenna.

### 7.3 Peak Indicators

For the procedures that follow, two operator feedback methods are employed:

- A DC voltage on the TX Out port that varies with received signal strength (PWM)
- An iSite graphic display depicting received signal strength in a histogram
7.3.1 PWM

When peaking the antenna, Satellite Routers (except the e850mp) generate a pulse train on the TX Out port. The duration of each pulse is proportional to the received signal strength. The method is known as Pulse Width Modulation (PWM). Pulses of differing duration are detected as different voltages by a DC voltmeter. Table 3 depicts the range of the PWM voltage output and the associated signal status. When peaking, the antenna is adjusted for maximum DC voltage as indicated by a DC voltmeter.

<table>
<thead>
<tr>
<th>Volts DC</th>
<th>Signal Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 2</td>
<td>Not in pointing mode, hardware problem, or off satellite</td>
</tr>
<tr>
<td>2 - 10</td>
<td>Detecting RF energy, but not locked on the downstream carrier</td>
</tr>
<tr>
<td>12 - 20</td>
<td>Locked on the downstream carrier</td>
</tr>
</tbody>
</table>

A reading of less than 2 Volts indicates that the signal level is below the detection threshold of the Satellite Router. When a signal at the correct frequency is detected, the PWM voltage increases sharply to between 2 and 10 Volts. After downstream carrier lock is achieved, the PWM voltage switches into the 12 to 20 Volt range. PWM voltages in this range increase linearly with increasing signal strength.

Note: A reading of 12 Volts or greater cannot be obtained unless the Satellite Router is locked to the correct spacecraft and network.

When power is applied to the Satellite Router, BUC power is available on the TX Out port immediately after power-on self-test (POST) has completed. To disable the BUC power supply and enable the PWM output, follow the steps in Section 7.4, "Peaking the Antenna".

7.3.2 Histogram

The iSite Antenna Pointing window provides a graphic representation of received signal strength over time. It provides a voltage amplitude display similar to an oscilloscope, displaying color-coded traces corresponding to the three voltage ranges shown in Table 3. Starting the histogram automatically disables BUC power and enables the PWM voltage output. Both the PWM voltage and the histogram display are used to peak the antenna.

The Antenna Pointing window provides a Current Signal Strength field that also indicates the peaking voltage. The reading may differ slightly from that indicated by the voltmeter, but is used for the same purpose.

7.4 Peaking the Antenna

Execute the procedures in the following sections to achieve peak received signal strength of the downstream link.

Note: If the Antenna Pointing Histogram does not operate as expected, refer to “PC Firewall” on page 4.
To Peak The Antenna

1. Ensure that the antenna is pointed off the marked heading by at least 20 degrees in azimuth.

2. In the iSite Tree View, right-click the Remote and select Align Antenna→Antenna Pointing. Alternately, click the icon in the tool bar. The Antenna Pointing dialog box appears. See Figure 22.

![Figure 22. Starting Antenna Pointing](image)

3. Click the Antenna Pointing tab.

4. Click the Start button.

5. A warning appears asking for confirmation that the BUC TX input is disconnected, and that the antenna is pointed off the proposed angle. If both are true, observe the voltmeter and click OK.

6. Verify that the BUC voltage is disabled by observing the voltage drop on the voltmeter. With no received signal, DC voltage drops to zero for about ten seconds, until the PWM and histogram display start. After that, the voltmeter indicates approximately 0.4 V of PWM output. See Figure 23.

7. Return the antenna azimuth to the position marked during course alignment. Slowly sweep the reflector a few degrees either side of the course azimuth while observing the peak indicators. The signal trace of the histogram progressively turns from red, to yellow, and then to green as downstream carrier signal strength increases. See Figure 23.
Peaking the Antenna

Figure 23. Antenna Pointing Histogram and Current Signal Strength
8. Move the antenna in azimuth so as to maximize the level of the green trace, the PWM output voltage, and the Current Signal Strength indication.

*Note:* Readings in the 12-24V range cannot be obtained from the wrong spacecraft or network.

9. If the downstream carrier signal is not found, increase or decrease the elevation setting in 2° increments and repeat the azimuth sweep until the signal is found.

10. When locked on to the carrier:
   a. Fine-adjust elevation for maximum.
   b. Fine-adjust azimuth for maximum.
   c. Secure the azimuth and elevation axes in place.
   d. Fine-adjust the feed polarization angle for maximum.

11. Record the final antenna pointing voltage reading and report the reading to the Network Operator.

12. In the Antenna Pointing window, click Stop to exit the antenna pointing mode.

13. Remove power from the Satellite Router. The unit must be restarted to completely exit the antenna pointing mode.

14. Disconnect the voltmeter from the Tx IF cable. Do not re-connect the BUC at this time.

*Note:* The Satellite Router must be reset to fully exit pointing mode and re-enable the operational state. Remove power from the Satellite Router before continuing.

If the site is configured as a secure mobile or “itinerant” installation, proceed to “Setting Geo Location for Secure Mobiles” on page 75 after peaking of the antenna has been completed.

Otherwise, proceed to “Cross Polarization” on page 79.
Peaking the Antenna
Part Two: Web iSite

The Satellite Router Installation and Commissioning Guide is divided into three parts. Part Two describes the commissioning process using the Web iSite user interface. Web iSite is used when commissioning the Evolution X1, X7, and e150 Satellite Routers.

Refer to Part One: iSite when commissioning the X3, X5, e8350, and e8xx Satellite Routers. Part Two contains the following chapters:

- Chapter 8, “Connecting with Web iSite”
- Chapter 9, “Loading Packages with Web iSite”
- Chapter 10, “Loading Options Files with Web iSite”
- Chapter 11, “Pointing the Antenna with Web iSite”
- Chapter 12, “Over the Air Download”
8 Connecting with Web iSite

This chapter describes the browser requirements for using Web iSite and how to determine the IP address of an X1, X7 or e150 Satellite Router if it is unknown.

This chapter includes the following sections:

- “Web iSite” on page 41
- “IP Address” on page 41
- “Restoring Factory Defaults” on page 42
- “Cold Start: X1 Outdoor” on page 45

Note: If the internal temperature of an Evolution X1 Outdoor Satellite Router is below -25°C when power is first applied, it may take up to four minutes to become operational. See “Cold Start: X1 Outdoor” on page 45 for details.

8.1 Web iSite

Web iSite is hosted by the X1, X7, and e150 Satellite Routers, each of which serve Web pages to a LAN connection. With Web iSite, a standard Web browser is used to access the Satellite Router to perform functions such as viewing status, loading software, pointing the antenna, and performing the cross-pol isolation and compression point procedures.

Web iSite is compatible with the following Web browsers:

- Internet Explorer (Version 7 and later)
- Mozilla Firefox (Version 8 and later)
- Google Chrome (Version 16 and later)

8.2 IP Address

To connect using Web iSite, the Satellite Router IP address and admin password must be known. The Satellite Routers are shipped with the following factory default settings:

- IP Address: 192.168.0.1
- Subnet Mask: 255.255.255.0
- DHCP Server: Enabled
- admin password: iDirect
Note: After an options file has been loaded on the Satellite Router, the factory default admin password, IP address, and DHCP configuration update to the values in the options file.

When shipped, the X1, X7, and e150 DHCP servers are enabled with a single client IP address enabling connection without modifying the IP address on the local PC. If DHCP is disabled on the Satellite Router, or if the local PC uses static IP addressing, follow the steps in “Local Area Connection” on page 14 to reconfigure the local IP settings.

If the IP address of an Evolution X1, X7, or e150 Satellite Router is unknown, follow the procedure in “Restoring Factory Defaults” on page 42 to restore the factory default IP address.

After determining the IP address, continue to “Loading Packages with Web iSite” on page 47.

8.3 Restoring Factory Defaults

An Evolution X1, X7, or e150 Satellite Router may be restarted in a factory default mode to restore the factory default settings. Uses of the factory default mode include:

- Connecting to a Satellite Router with an unknown IP address
- Reloading the factory software image for troubleshooting purposes

Restart the Satellite Router in the factory default mode if a connection cannot be established or software loading fails. An operator must be physically present at the Satellite Router location to press the reset button.

To enter the factory default mode, press the reset button on the Satellite Router for a minimum specified period of time as described in the following sections.

Note: For the Evolution X7 Satellite Router only, entering Factory Default Mode deletes all previous user configurations. Reload the package and options files after invoking Factory Default Mode. For Evolution X1 and e150 satellite routers, the package and options files are not deleted.

8.3.1 X1 Indoor/Outdoor

The reset buttons of the indoor and outdoor versions of the X1 are in different locations:

On the Evolution X1 Indoor Satellite Router, the reset button is accessed through a small hole between the Rx In port and the LAN port. To press the reset button, insert a paper clip or similar tool into the access hole and press gently. See Figure 24.

![Figure 24. X1 Indoor Rear Panel: Reset Access Hole](image)
On the Evolution X1 Outdoor Satellite Router, the reset button is located immediately above the RJ-45 connector of the LAN port. Use a small, flat-blade screwdriver or similar tool to press the button. See Figure 25.

![Figure 25. X1 Outdoor Front Panel: Reset Button](image)

**Note:** To access the LAN port and reset button on an Evolution X1 Outdoor Satellite Router, remove the M25 Cable Gland covering the LAN port.

The reset button has two uses:
- Press the reset button for less than eight seconds to restart the Satellite Router in the operational mode. This is identical to a power-on restart.
- Press the reset button for eight seconds or longer to restart the Satellite Router in the factory default mode.

When in the factory default mode, the Satellite Router executes the factory firmware using the default settings even if a software package and/or options file have been loaded on the Satellite Router previously.

The default settings are:
- LAN IP address: 192.168.0.1
- Subnet Mask: 255.255.255.0
- DHCP Server: enabled with a single client address of 192.168.0.2
- Password (for both user and admin accounts): iDirect

**To Restart an Evolution X1 Satellite Router in Factory Default Mode:**

1. Press and hold the reset button for at least eight seconds.
2. Release the reset button.

**Alternate Procedure:**

1. Remove power from the Satellite Router.
2. Press and hold the reset button.
3. Apply power to the Satellite Router.
4. Release the reset button after eight seconds.
Note: For a complete description of X1 features, controls, and operational characteristics, refer to the X1 Installation, Support, and Maintenance Manual.

Return to the procedures in this chapter beginning on page 41 to connect to the Satellite Router. Note that if package and options files have been loaded previously, although ignored while in the Factory Default mode, they will be made active following a return to the operational mode.

When finished loading the software package and options files, restart the Satellite Router to activate the files and return to the operational mode.

8.3.2 X7

The Evolution X7 Satellite Router provides a manual reset button similar to the X1 Indoor. The reset button of the X7 is located midway between the TX Out port and the RX1 In port. See Figure 26.

![Figure 26. Evolution X7 Reset Button: Location](image)

To Restart an Evolution X7 Satellite Router in Factory Default Mode:

1. Press and hold the reset button for at least fifteen seconds.
2. Release the reset button.

Note: For a complete description of X7 features, controls, and operational characteristics, refer to the X7 Installation, Support, and Maintenance Manual.

8.3.3 e150

Factory default mode of the e150 is entered by applying a contact closure across the reset lines of the J5 Reset Header for a minimum of eight seconds. The factory default mode attributes are the same as for the X1 Indoor and Outdoor Satellite Routers. See the iDirect e150 Satellite Router Integration Guide for details.
8.4 Cold Start: X1 Outdoor

An Evolution X1 Outdoor Satellite Router is designed to operate in ambient temperatures as low as \(-40^\circ\text{C}\). However, if the Satellite Router is without power long enough for the internal temperature to fall below \(-25^\circ\text{C}\), a warm-up period is required before becoming operational. The warm-up period for the X1 Outdoor Satellite Router depends on the internal modem temperature measured at the time power is restored. The warm-up periods are defined in Table 4.

<table>
<thead>
<tr>
<th>Internal Modem Temperature</th>
<th>Warm-Up Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>(-25^\circ\text{C} \text{ to } -35^\circ\text{C})</td>
<td>1.5 minutes</td>
</tr>
<tr>
<td>(-35^\circ\text{C} \text{ to } -40^\circ\text{C})</td>
<td>4.0 minutes</td>
</tr>
</tbody>
</table>

During the warm-up period, a Web iSite connection to the Evolution X1 Outdoor Satellite Router can be established using a Web browser. Although the X1 Outdoor has only one physical LED indicating power, four LED-like indicators on the X1 Web iSite pages show the current state of the Satellite Router. During warm up, the LEDs display the following colors:

- **Receive**: Yellow
- **Network**: Yellow
- **Transmit**: Yellow
- **Power**: Green

Using Web iSite, observe the Evolution X1 Dashboard (Figure 29 on page 48) during the warm-up period. On the Dashboard:

- The **Temperature** field increases as the modem warms up.
- The **Satellite Rx** field shows **Waiting for Demod Lock**.

Once warm-up is complete, the Web iSite status indicators show the same status as the Evolution X1 Indoor Satellite Router LEDs. See Table 9 on page 96 for details.
9 Loading Packages with Web iSite

This chapter describes how to log in to Web iSite and how to load the remote image software package on the X1, X7, and e150 Satellite Routers.

This chapter includes the following sections:

• “Logging In to Web iSite” on page 47
• “Loading the Package File” on page 49

9.1 Logging In to Web iSite

Perform the steps in the following section to establish communication with the Satellite Router using Web iSite.

To log in:

1. Connect a crossover or straight-through Ethernet cable between the LAN port of the local PC and the LAN port of the Satellite Router. (For an Evolution X7, connect to the port labeled LAN 1.)

2. Open a Web browser.

3. Enter the IP address of the Satellite Router into the address bar of the Web browser in the following format:

   https://IP Address/

   where IP Address is the IP address of the Satellite Router. See Figure 27.

4. When the Login page appears:
   a. For User, enter admin.
   b. For Password, enter the admin password of the Satellite Router.
   c. Click Login
Loading Packages with Web iSite

Note: The factory default admin password is iDirect. However, after an options file has been loaded and the Satellite Router has been reset, the password changes to match the password in the options file.

After login, the Web iSite Dashboard appears with basic information about the Satellite Router, such as the Model Type and Serial Number. Figure 29 shows a partial example of the X7 Dashboard.

---

Figure 28. Web iSite Login Page

Figure 29. Web iSite Dashboard Example: Evolution X7
WARNING! Always load the software package regardless of the Software Version shown in the dashboard. Load the new package even if the Release Number and/or Build Number displayed for the Software Version is identical to the software package downloaded from the TAC Web site for this release.

9.2 Loading the Package File

After establishing communications via Web iSite and logging in, the remote software package file is loaded on the Satellite Router. If using a Downstream Template to load both software and options file, skip to “Downstream Template” on page 56.

Table 5 identifies the folder names containing the package files, and the contents of each folder. The Images folder is in the location on the local PC created by the unzip operation.

<table>
<thead>
<tr>
<th>Satellite Router</th>
<th>Location</th>
<th>Packages to Download</th>
</tr>
</thead>
</table>
| X1               | /Images/Remote_Evolution_X1_e150 | evo_x1_indoor_rmt-15.0.0.0.pkg  
|                  |                           | evo_x1_outdoor_rmt-15.0.0.0.pkg                             |
| X7               | /Images/Remote_Evolution_X7  | evo_X7_rmt-15.0.0.0.pkg                                      |
| e150             | /Images/Remote_Evolution_X1_e150 | evo_e150_rmt-15.0.0.0.pkg                                     |

To Load the Package File:

1. In the top navigation bar in Web iSite, click the Admin button. The File Management page appears by default (Figure 30). If not, click the File Management link on the left.

Figure 30. Web iSite File Management Page: Load Sections
2. In the **Load Package** section of the **File Management** page, click **Browse**.

3. Navigate to the appropriate model-specific packages on the local PC. They are located in the **Images** folder created during the unzip operation. See **Figure 31**.

![Figure 31. Selecting Package File](image)

**Note:** There are two **Evolution X1** package files: one for **Evolution X1 Indoor Satellite Routers**, and one for **Evolution X1 Outdoor Satellite Routers**.

4. Double-click the correct package for the Satellite Router model being commissioned.

5. Click **Load**. The **Load Package** status box (**Figure 32**) appears upon completion.

![Figure 32. Load Package Status Box](image)

6. Click **OK** in the **Load Package** status box.
**Note:** The Evolution X7 Satellite Router has two flash partitions from which it can execute the software package. If one partition fails, the Satellite Router will switch to the other partition. After performing the procedure “Loading Options Files with Web iSite” on page 53 for an Evolution X7 Satellite Router, iDirect highly recommends loading the X7 software package a second time. This ensures that both partitions contain the correct software.

After loading the package file, proceed to “Loading Options Files with Web iSite” on page 53.
10 Loading Options Files with Web iSite

This chapter describes how to load the options file on the X1, X7, and e150 Satellite Routers using the Web iSite application.

This chapter includes the following sections:

- “Options File” on page 53
- “Downstream Template” on page 56

10.1 Options File

*Note: If using a Downstream Template instead of individual options files, skip to “Downstream Template” on page 56.*

The remote options file contains network and site-specific information such as operating frequencies, geographic location, and other network parameters. Options files are generated in iBuilder, and provided to the installer by the Network Operator.

An options file must be loaded on the Satellite Router in order to acquire into the network.

After loading the remote package file, the options file may be loaded. Loading an options file is similar to loading a remote software package.

**To Load the Options File:**

1. In the Load Options File section of the File Management page, click **Browse**.
2. Navigate to the folder on the local PC that contains the applicable site-specific options file.
3. Double-click the options file or click **Open**.
4. Verify that the correct filename is displayed in the Load Package window (Figure 33).
5. Click Load. The Load Options File status box (Figure 34) appears upon completion.

![Load Options File Status Box]

Figure 34. Load Options File Status Box

6. Close the Load Options File status box.

7. In the Restart Device section of the File Management page, click Restart.

8. If this is an Evolution X7 Satellite Router:
   a. Wait until the Satellite Router restarts.
   b. Log on to Web iSite.
c. Execute the procedure “Loading the Package File” on page 49 a second time to load the second flash partition with the current software package. It is not necessary to reload the options file or restart the Satellite Router again before continuing to the next procedure.

*Note: iDirect recommends loading the X7 software package a second time. This allows the Satellite Router to operate using the software in the second partition in the unlikely event of an unrecoverable error in the operational partition.*

d. In the Software Loaded section of the Web iSite Admin→File Management page, verify that both Version 1 and Version 2 have the latest software release and build number in the Version field. Figure 35 shows an X7 Satellite Router with the same software package loaded in both partitions.

![File Management](image)

*Figure 35. Evolution X7 with Latest Software in Both Partitions*

Proceed to “Pointing the Antenna with Web iSite” on page 59.
10.2 Downstream Template

Evolution X1, X7, and e150 Satellite Routers support the Downstream Template feature in Web iSite. The Downstream Template is provided as an option to speed commissioning of large numbers of remote sites by avoiding the requirement for the installer to obtain and manage a large number of individual options files. This feature also allows the Satellite Router to receive its remote software package over-the-air from the NMS as part of the commissioning procedure.

The Downstream Template contains the minimum information necessary to enable reception of the downstream broadcast from the hub. Remote sites with a common downstream channel, e.g., Inroute Groups using the same network and remote site LNB parameters, can use a single Downstream Template file to enable reception on all the Satellite Routers in that network. Once the Downstream Template is loaded and the Satellite Router locks to the downstream carrier, the Network Operator can use iBuilder to download the remote software package and the remainder of the site-specific options data over-the-air from the NMS. A separate Downstream Template file is required for each discrete downstream channel or network.

Note: The downstream template is only available for X1 Satellite Routers already running iDX Release 3.2 or later. The software version is displayed on the Web iSite dashboard. See Figure 29 on page 48.

Note: In the absence of a downstream template, the downstream parameters can be entered manually on the Web iSite Downstream Configuration page (Figure 37).

The Downstream Template file is produced by the Network Operator. It is a text file in JSON format that can be viewed and edited with a text editor such as Notepad. Downstream Template files must have the .json file extension in the file name. Figure 36 shows an example of a Downstream Template JSON file.

![Figure 36. Downstream Template: Example](image)

To Load the Downstream Template:
1. In Web iSite, click the **Commissioning** button.

2. Click the **Downstream Config** link on the left to view the **Downstream Configuration** page.

   Figure 37 shows the **Downstream Configuration** page of an Evolution X7 Satellite Router.

---

**Figure 37. Web iSite Downstream Configuration Page**
3. At the bottom of the page under Configuration From File, click Browse.
4. Navigate to the location on the local PC where the .json file is located.
5. Select the Downstream Template file by double-clicking the filename or clicking Open.
6. Under Configuration From File, click Apply.
7. The data fields in the Downlink, LNB, and Package Multicast sections update with the information in the Downstream Template file.
8. Confirm that the displayed data is correct.
9. In the top navigation bar in Web iSite, click the Admin button.
10. In the Restart Device section of the File Management page, click Restart.
11. In the Restart confirmation box (Figure 38), click Restart. The Satellite Router restarts and loads the new configuration.

**Figure 38. Restart Confirmation Box**

*Note:* Restarting forces Web iSite to log out of the Satellite Router. Log in again using the default IP address and password.

After loading the Downstream Template and restarting the Satellite Router, proceed to “Pointing the Antenna with Web iSite” on page 59. Once the antenna is correctly pointed, the Network Operator can use iBuilder to push the software package and the remote-side options file.
11 Pointing the Antenna with Web iSite

This chapter explains how to point the antenna using Web iSite. The chapter is applicable when commissioning the Evolution X1, X7, and e150 Satellite Routers.

This chapter includes the following sections:
• “Preparation” on page 59
• “Initial Alignment” on page 59
• “Peak Indicators” on page 61
• “Peaking the Antenna” on page 62

11.1 Preparation

The following procedure assumes that the BUC and LNB are in the operational state. The following items are required for this procedure:
• DC voltmeter
• 75Ω F-female voltmeter input adapter

To Prepare for Peaking:
1. If the Satellite Router is on, disconnect power.
2. Ensure that the Receive IF cable is connected from the LNB to the Satellite Router.
3. Ensure that the Transmit IF cable is connected to the Satellite Router.
4. Disconnect the Transmit IF cable from the BUC and connect it to the DVM.
5. Reconnect power to the Satellite Router.

11.2 Initial Alignment

Web iSite provides a Look Angle Calculator to compute the initial azimuth, elevation, and polarity settings for the antenna. The initial settings provide a starting point from which to begin fine-pointing or ‘peaking’ of the antenna.

11.2.1 Calculating Look Angle

Web iSite calculates look angle based upon geographic location data extracted from the options file, or entered manually by the user.
For the procedures that follow, log in to the Satellite Router as described in “Logging In to Web iSite” on page 47.

To Calculate Look Angle:

1. In the navigation bar at the top of the Web iSite window, click the Commissioning button. Select Angle Calculator from the list in the left-hand menu pane. See Figure 39.

2. Verify that the Remote Location and Spacecraft Position information is correct. The data entry fields are automatically populated with data extracted from the options file. The entries may be overridden by typing in the text boxes; however the overrides will be lost upon exit.

3. Under Elevation, enter the Elevation Offset of the antenna. Refer to the antenna manufacturer’s specifications for the offset angle.

After the required data is entered, Web iSite automatically calculates azimuth, elevation, and polarization angles and displays the data under Gross Antenna Pointing.

![Figure 39. Web iSite Commissioning Dialog Box: Angle Calculator](image)
**Note:** Write down the pointing values, or leave the screen open. The data are needed in the following sections to perform antenna pointing.

### 11.2.2 Coarse Alignment

Use the data provided in the previous section to perform a coarse alignment of the antenna towards the satellite. The following items are required:

- Compass or GPS receiver
- Site magnetic variation data
- Inclinometer
- Indelible marker
- Hand tools as required

For the procedure that follows, it is not necessary to completely re-tighten the antenna axis fixing hardware. Satellite acquisition and fine pointing are performed later.

**To Perform Coarse Alignment:**

1. Determine the site magnetic variation, available on the Web.
2. Refer to the **Gross Antenna Pointing** area of the **Angle Calculator**. Using an inclinometer or protractor, adjust the feed horn assembly to the approximate angle indicated in the **Polarization Offset** field. See **Figure 39**.
3. Using an inclinometer, set antenna elevation to the value provided in the **Elevation Actual** field. Remember that this value is the true elevation minus the antenna offset angle.
4. Using a compass or GPS unit, set antenna azimuth to the approximate angle indicated in the **Azimuth True** field. Be sure to apply the local magnetic variation to the compass reading. West variation must be added, and East variation must be subtracted from the value indicated by the compass. The result is the true azimuth.
5. Mark the coarse azimuth with a line drawn across the lower section of the azimuth mount and the pole, using an indelible marker.

After completion of coarse alignment, execute the procedures in the sections that follow to peak the antenna.

### 11.3 Peak Indicators

For the procedures that follow, two operator feedback methods are employed:

- A DC voltage on the **TX Out** port that varies with received signal strength (PWM)
- A graphic display depicting received signal strength in a histogram

#### 11.3.1 PWM

When peaking the antenna, the Satellite Router generates a pulse train on the **TX Out** port. The duration of each pulse is proportional to the received signal strength. The method is
known as Pulse Width Modulation (PWM). Pulses of differing duration are detected as different voltages by a DC voltmeter.

Table 6 depicts the range of the PWM voltage output and the associated signal status. When peaking, the antenna is adjusted for maximum DC voltage as indicated by a DC voltmeter.

<table>
<thead>
<tr>
<th>Volts DC</th>
<th>Signal Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 2</td>
<td>Not in pointing mode, hardware problem, or off satellite</td>
</tr>
<tr>
<td>2 - 10</td>
<td>Detecting RF energy, but not locked on the downstream carrier</td>
</tr>
<tr>
<td>12 - 20</td>
<td>Locked on the downstream carrier</td>
</tr>
</tbody>
</table>

A reading of less than 2 Volts indicates that the signal level is below the detection threshold of the Satellite Router. When a signal at the correct frequency is detected, the PWM voltage increases sharply to between 2 and 10 Volts. After downstream carrier lock is achieved, the PWM voltage switches into the 12 to 20 Volt range. PWM voltages in this range increase linearly with increasing signal strength.

**Note:** A reading of 12 Volts or greater cannot be obtained unless the Satellite Router is locked to the correct spacecraft and network.

When power is applied to the Satellite Router, BUC power is available on the TX Out port immediately after power-on self-test (POST) has completed. To disable the BUC supply and enable the PWM output, follow the steps in “Peaking the Antenna” below.

### 11.3.2 Graphic Display

The Web iSite Antenna Pointing screen provides a graphic representation of received signal strength over time. It provides a voltage amplitude display similar to an oscilloscope, displaying a color-coded bar graph corresponding to the three voltage ranges shown in Table 6. The display is enabled when Antenna Pointing is selected on the Commissioning screen.

Both the PWM voltage and the graphic display are used to peak the antenna.

### 11.4 Peaking the Antenna

Execute the procedures in the following sections to achieve peak received signal strength of the downstream link.

**To Peak The Antenna**

1. Be certain that the antenna is pointed off the marked heading by at least 20 degrees in azimuth.
2. In the navigation bar at the top of the Web iSite window, click the Commissioning button.
3. Click Antenna Pointing (at left) to view the Antenna Pointing page. The graphic display appears and begins to scroll across the screen.
4. For dual-receiver models such as the X7, select Rx1 or Rx2 at upper-right. See Figure 40.
5. Verify that the Tx IF is connected from the **TX Out** port of the Satellite Router to the input of the voltmeter. Move the antenna at least 20 degrees away from the marked heading in azimuth.

6. While observing the voltmeter, click **Start Tx PWM**.

7. Verify that the BUC voltage is disabled by observing the voltage drop on the voltmeter. With no received signal, DC voltage drops to zero for about ten seconds, until the PWM starts. After that, the voltmeter indicates about 0.4 V of PWM output (no signal).

8. Return the antenna azimuth to the position marked during coarse alignment. Slowly sweep the reflector a few degrees either side of the coarse azimuth while observing the peak indicators. The bar graph progressively turns from red, to yellow, and then to green as downstream carrier signal strength increases.
9. Move the antenna in azimuth so as to maximize the level of the green bar and the PWM output voltage. See Figure 41.

10. If the downstream carrier signal is not found, increase or decrease the elevation setting in 2° increments and repeat the azimuth sweep until the signal is found.

11. When locked on to the carrier:
   a. Fine-adjust elevation for maximum.
   b. Fine-adjust azimuth for maximum.
   c. Lock the azimuth and elevation axes in place.
   d. Fine-adjust the feed polarization angle for maximum.

12. Record the final antenna pointing voltage reading and report the reading to the Network Operator.

13. On the Antenna Pointing screen, click Start Tx PWM to exit the antenna pointing mode.

14. Remove power from the Satellite Router. The unit must be restarted to completely exit the antenna pointing mode.

15. Disconnect the voltmeter from the Tx IFL. Do not re-connect the BUC at this time.

---

**Figure 41. Web iSite: Antenna Peak Indication**

*Note: The Satellite Router must be reset to fully exit pointing mode and re-enable the operational state. Remove power from the Satellite Router before continuing.*
If both the software package and options file have already been loaded on the Satellite Router, and the remote site is not being configured as a secure mobile, proceed to “Cross Polarization” on page 79.

If both the software package and options file have already been loaded on the Satellite Router, and the remote site is being configured as a secure mobile, proceed to “Setting Geo Location for Secure Mobiles” on page 75.

If using the Downstream Template feature to download both software and configuration (X7 only) or configuration only over-the-air, proceed to “Over the Air Download” on page 67.
12 Over the Air Download

This chapter explains how to download the software package and/or remote-side options file to a Satellite Router from the NMS when a Downstream Template has been loaded or the downstream configuration has been manually configured using Web iSite.

Note: Over the air download is only available for X1 Satellite Routers already running iDX Release 3.2 or later. The software version is displayed on the Web iSite dashboard. See Figure 29 on page 48.

This chapter includes the following sections:
- “Software Package and Options Push” on page 67
- “Options File Only Push” on page 69
- “Verify the Download” on page 69

12.1 Software Package and Options Push

This section explains how to work with the Network Operator to push both the software package and remote-side options file to an Evolution X1, X7 or e150 Satellite Router. To push only the options file, follow the procedure in “Options File Only Push” on page 69.

The procedure assumes that:
- The Downstream Template has been loaded on the Satellite Router or the downstream configuration has been manually configured using Web iSite
- The antenna has been pointed and peaked
- The Satellite Router is receiving the downstream carrier

Because the antenna is peaked and the Satellite Router is receiving the downstream broadcast, the Network Operator is able to multicast the software package to the Satellite Router over-the-air and then push the options file using UDP.

To Push the Software Package and Options File:

1. Confirm that the Tx output of the Satellite Router is not connected to the voltmeter or the BUC.
2. Confirm that the Satellite Router was restarted after antenna peaking.
3. Confirm that the Satellite Router is locked to the downstream carrier.
4. Contact the Network Operator, and request a Multicast Package Download of the remote software package and a UDP options file push.

5. The Network Operator should perform the following steps in iBuilder:
   a. Verify the remote-side configuration.
   b. Select Package Download→Multicast at the Network level of the iBuilder Tree.
   c. Select the appropriate Remote package under Hardware in the Multicast Download dialog box.
   d. Select only this remote in the Remotes section of the Multicast Download dialog box.
   e. Ensure that Reset is not selected.
   f. Click Start.
   g. Wait for the software package download to complete.
   h. Click Close to close the Multicast Download dialog box.
   i. Right-click the remote in the iBuilder Tree and select Apply Configuration→Push Remote Side with Reset (UDP).

6. The Satellite Router restarts and the new software package and options file become active.

7. Obtain the new admin password from the Network Operator.

8. Log in to Web iSite with the new password.

9. Check the parameters in “Verify the Download” on page 69 to verify that the download was successful.

10. If this is an Evolution X7 Satellite Router:
    a. Have the Network Operator perform Step b through Step h a second time to load the second flash partition with the current software package.
    b. Wait until the Network Operator indicates that the package download is complete.
    c. In Web iSite, click the Admin button at the top of the Web page.
    d. Refresh the browser Web page.
    e. In the Software Loaded section of the Admin→File Management page, verify that both Version 1 and Version 2 have the latest software release and build number in the Version field. See Figure 35 on page 55.

   Note: iDirect recommends loading the X7 software package to the second partition. This allows the Satellite Router to switch to the second partition in the unlikely event of an unrecoverable error in the operational partition.
12.2 Options File Only Push

This section explains how to work with the Network Operator to push the remote-side options file to an Evolution X1, X7 or e150 Satellite Router. If pushing both the software and options file, follow the procedure in “Software Package and Options Push” on page 67.

The procedure assumes that:

- The remote software package has been loaded on the Satellite Router using Web iSite
- The Downstream Template has been loaded on the Satellite Router or the downstream configuration has been manually configured using Web iSite.
- The antenna has been pointed and peaked
- The Satellite Router is receiving the downstream carrier

Because the antenna is peaked and the Satellite Router is receiving the downstream broadcast, the Network Operator is able to transmit the options file to the Satellite Router over-the-air using a remote-side UDP push.

To Push the Options File:

1. Confirm that the Tx output of the Satellite Router is not connected to the voltmeter or the BUC.
2. Confirm that the Satellite Router was restarted after antenna peaking.
3. Confirm that the Satellite Router is locked to the downstream carrier.
4. Contact the Network Operator, and request a UDP push of the options file.
5. The Network Operator should perform the following steps in iBuilder:
   a. Verify the remote side configuration.
   b. Right-click the remote In the iBuilder Tree and select Apply Configuration→Push Remote Side with Reset (UDP).
6. The Satellite Router restarts and the new options file becomes active.
7. Obtain the new admin password from the Network Operator.
8. Log in to Web iSite with the new password.
9. Check the parameters in “Verify the Download” on page 69 to verify that the download was successful.

12.3 Verify the Download

Multicast and UDP push are one-way processes. The NMS sends data but does not receive confirmation. In most cases the Satellite Router receives and loads the new data without issue. However it is important to verify that the download was received and installed correctly. The ability to log in with the new admin password is an indication that the options file was received and loaded correctly.
Verify the Download

Confirm that the Software Version on the Web iSite Dashboard is correct. This is especially important when the software package was multicast to the Satellite Router. See Figure 42.

Figure 42. Web iSite: Confirming the Software Version

Confirm that the LNB and BUC frequency information is correct. The data can be viewed in Web iSite by clicking the Status button, and selecting ODU Status from the left-hand menu pane. See Figure 43.

Figure 43. Web iSite: ODU Status
The remote site geographic coordinates can be confirmed by scrolling to the bottom of the Status→Modem Status page.

The options file data can also be confirmed by viewing the options file directly. Navigate to File Management on the Admin page of Web iSite. View the new options file by clicking View under Retrieve Options File. Frequency translation data appears under the [FREQ_TRANS] heading. See Figure 44.

![Options File](image)

**Figure 44. View Options File: Frequency Translation**

In the options file, `down_translation` is the frequency of the LNB local oscillator in MHz, and `up_translation` is the frequency of the BUC local oscillator in MHz.
Site geographic coordinates and spacecraft location can be viewed under the [MODEM_INSTALLATION] heading, and the rx_freq and tx_freq values are located under the [MODEM_PARAMETERS] heading.

If the remote site is being configured as a secure mobile, proceed to “Setting Geo Location for Secure Mobiles” on page 75. Otherwise, proceed to “Cross Polarization” on page 79.
Part Three: Commissioning

The Satellite Router Installation and Commissioning Guide is divided into three parts. Part Three describes accessing the spacecraft and commissioning the return link. The procedures in Part Three are generally applicable when commissioning all remote sites, whether using iSite or Web iSite.

Part Three contains the following chapters:

• Chapter 13, “Setting Geo Location for Secure Mobiles”
• Chapter 14, “Cross Polarization”
• Chapter 15, “1 dB Compression Point and Maximum Power”
• Chapter 16, “Acquiring the Network”
• Chapter 17, “Setting Power”
• Chapter 18, “Post Acquisition Activities”
13 Setting Geo Location for Secure Mobiles

This chapter describes how to enter the geographic location of a secure, mobile Satellite Router.

This chapter includes the following sections:

- “Secure Mobile Remotes” on page 75
- “Setting Geographic Location using the Console” on page 76
- “Setting Geographic Location of an X7” on page 76

Note: This chapter describes a specific operational scenario for configuring Satellite Routers as both Mobile and Secure. If commissioning a Satellite Router that does not fall into this category, skip this chapter.

Note: Evolution X1, X3, and e150 Satellite Routers cannot function as mobile or “itinerant” remotes.

13.1 Secure Mobile Remotes

A “secure mobile remote” is a mobile remote for which the Satellite Router’s geographic location has not been recorded by the Network Operator and is not displayed either by the NMS clients or by the remote commissioning and monitoring software. Secure mobile remotes are configured in iBuilder by selecting the Mobile Security option on the Remote Geo Location tab.

A secure mobile remote may be either a COTM mobile remote that moves across the footprint of the satellite beam or an “itinerant” remote that is periodically moved from fixed location to fixed location.

Once entered, secure geographic coordinates cannot be verified locally. Therefore it is important to exercise care when entering the data. The only sign that incorrect data for the site has been entered will be failure of the Satellite Router to acquire the network. If in doubt, re-enter the information as soon as possible.

WARNING! Geographic coordinates must accurately reflect the current geographic location. If the values are incorrect, the Satellite Router will not acquire the network and may interfere with network operation.
If commissioning an Evolution X7 Satellite Router, see “Setting Geographic Location of an X7” on page 76. For all other mobile remotes, site latitude and longitude coordinates are entered via the console port using the `latlong` command as described in the following section.

*Note:* If the Satellite Router is not configured as mobile on the iBuilder Remote Geo Location tab, it is not possible to change the geographic location from the console or from Web iSite.

### 13.2 Setting Geographic Location using the Console

To set the geographic location using the console:

1. Telnet to the Satellite Router or open a console session using the procedure “Connecting to the Console Port” on page 17.
2. Log in as root and `telnet localhost` to the admin account.
3. At the prompt, enter the following:

```
latlong <latitude> <N or S> <longitude> <E or W>
```

   Where:

   - `latitude` is the current latitude in decimal notation `N`
   - `or S` is either `N` (for North) or `S` (for South) latitude
   - `longitude` is the current longitude in decimal notation
   - `E or W` is either `E` (for East) or `W` (for West) longitude

   *Note: Do not enter the <> marks.*

**CAUTION:** Double-check the geographic coordinates before pressing ENTER.

### 13.3 Setting Geographic Location of an X7

Enter the geographic coordinates for an Evolution X7 Satellite Router using Web iSite.

**To set the geographic location of an X7:**

1. Establish a connection to Web iSite using the procedure as described in “Connecting with Web iSite” on page 41.
2. Log in to Web iSite.
3. Click the **Commissioning** button at the top of the Web page.
4. In the left-hand menu pane under **Commissioning**, click **Geo Location** to open the Geo Location page (Figure 45).
5. Enter the remote site latitude and longitude in the appropriate data entry fields using decimal notation.
   
   **Note:** The numerical data may be typed into the fields, or modified by clicking the arrow buttons.

6. Select degrees of North or South latitude, and East or West longitude.

7. After entering the correct information, click **Set Location**.
   
   **CAUTION:** Double-check the geographic coordinates before clicking **Set Location**.

8. Click the **Admin** button at the top of the Web page.

9. Restart the Satellite Router by clicking **Restart** on the **File Management** page.

   After setting geographic location, continue with the procedures in “Cross Polarization” on page 79.
14 Cross Polarization

This chapter describes how to minimize return link cross-pol energy under the guidance of the satellite access control center. This section includes instructions for both the iSite client and the Web iSite interface.

This chapter includes the following sections:
- “Overview” on page 79
- “Satellite Access” on page 81
- “Performing Cross-Pol Adjustment” on page 82
- “After Securing the Antenna” on page 83

14.1 Overview

Cross-pol isolation is measured over-the-air by the satellite access control center. Be prepared to contact the Network Operator by telephone.

Transmit cross-pol isolation is maximized in order to limit interference to users on the opposite polarity of linearly-polarized satellite transponders. Typically, the spacecraft operator requires a minimum of 30 dB of isolation. To measure this, the terminal must transmit at a power level at least 30 dB above the noise floor of the transponder. The satellite access control center measures and compares the received co-pol and cross-pol energy to determine if the site meets polarity isolation standards.

VSAT terminals using circularly-polarized feed systems need not perform cross-pol tests.

To Prepare for Cross-Pol Adjustment:

1. Disconnect power from the Satellite Router.
2. **Disconnect the receive IF cable from the Satellite Router.**
3. Connect the transmit IF cable to the BUC Tx input.
4. Connect power to the Satellite Router.
5. For all Satellite Routers except the Evolution X1, X7, and e150, connect to the Satellite Router using iSite. If commissioning an Evolution X1, X7, or e150, connect using a Web browser.
6. Log in as **Admin**.
7. If using iSite, right-click the Remote in the iSite Tree View and select Align Antenna → Cross Polarization to open the Cross Polarization dialog box (Figure 46). Alternately, click the icon in the tool bar.

![Cross Polarization Dialog Box]

Figure 46. iSite Cross Polarization Dialog Box

8. If using Web iSite:
   
a. In the navigation bar at the top of the Web iSite window, click the Commissioning button.
   
b. Click the Cross Polarization link on the left to view the Cross Polarization page. See Figure 47.
14.2 Satellite Access

**WARNING!** Do not click the Start button until instructed to do so by the satellite access control center. Clicking the button causes the Satellite Router to transmit a continuous-wave (CW) signal to the satellite.

While still connected to the Satellite Router, call the Network Operator. The Network Operator will establish a conference call with the satellite access control center. The access controller will assign an uplink frequency for performing the cross-pol isolation adjustment. For a Satellite Router that transmits an SCPC return channel, the assigned test frequency may be the same as the final operating frequency. For TDMA terminals, cross-pol must be measured at a test frequency different from the traffic-carrying channel.
14.2.1 Preparation

Follow the steps below to prepare for satellite access and cross-pol adjustment:

To Prepare for Satellite Access:

1. Loosen the fasteners securing the feed, as well as the hose clamp on the BUC, so that the entire assembly (feed, BUC, and LNB) rotates freely.

2. Provide the final antenna pointing voltage reading to the Network Operator. The Network Operator records the value.

3. Obtain the test frequency from the satellite access controller.

4. In RF Uplink Frequency in iSite (Figure 46) or Web iSite (Figure 47), enter the test frequency.

   Note: The BUC LO Frequency is read from the options file loaded on the Satellite Router. Using the RF Uplink Frequency and BUC LO Frequency, the L-band TX Frequency is calculated automatically.

5. Verify with the Network Operator that the displayed L-band TX Frequency is correct.

6. In Adjust Transmit Power, set power to -35 dBm.

14.3 Performing Cross-Pol Adjustment

During adjustment of the antenna feed, the satellite access controller observes the transmitted signal on a spectrum analyzer, switching from co-pol to cross-pol to compare levels. The controller will ask for power to be increased until sufficient energy is available to detect the cross-pol signal. At that time a polarity adjustment is made. The controller may ask for more changes in transmit power and additional polarity adjustments as needed until the required level of isolation is achieved.

The access controller will not specify a transmit power in absolute terms, such as -35 dBm or -20 dBm. Instead, the controller will ask for power increases or decreases in relative terms, such as a 1 dB increase, or a 2 dB decrease. Perform the following procedure when instructed by the access controller.

To Start the CW Carrier and Adjust TX Polarity Isolation:

1. If using iSite, click the Start CW button in the Cross Polarization dialog box (Figure 46).

   Note: iSite may generate an error message after clicking the Start CW button. If this happens, click the Stop button and try again.

2. If using Web iSite:
   a. In the Modulation field of the Modulator section, select Off CW (Figure 47).
   b. Click the Start button.

3. In iSite or Web iSite, adjust the transmit power as instructed by the access controller by selecting the appropriate power value in the Transmit Power section of the Cross Polarization screen. (See Figure 46 or Figure 47.)

4. At the instruction of the access controller, rotate the feed slowly in one direction. Move the assembly in small (1/2°) increments.
5. Wait for the access controller to make a measurement. The access controller may say to continue moving the feed in the same direction, or to reverse direction. Continue as directed until the required isolation is achieved.

6. Secure all fasteners and the hose clamp.

It may be necessary to re-peak azimuth and elevation in order to achieve sufficient cross-pol isolation. The access controller may ask for fine adjustments in azimuth or elevation before repeating the cross-pol adjustment. Follow the directions of the access controller. Securely fasten all antenna axes after peaking and isolation have been optimized.

14.4 After Securing the Antenna

Wait for the access controller to verify that cross-pol isolation and peaking did not change due to tightening of the antenna axis fixing hardware. Confirm that the Network Operator has recorded the final cross-pol isolation value.

If directed to modulate the test carrier: If using iSite:

1. Click the Start Modulated button (Figure 46) to open the Specify Modulated Carrier dialog box.

2. In the Specify Modulated Carrier dialog box (Figure 48), enter the Symbol Rate as directed.

![Figure 48. iSite: Specify Modulated Carrier Dialog Box](image)

3. Click OK to modulate the carrier.

If using Web iSite:
   a. In the Modulation field of the Modulator section, select BPSK (Figure 47).
   b. Enter the Symbol Rate as directed.
   c. Click the Start button.

After completing the cross-pol isolation adjustments, proceed to “1 dB Compression Point and Maximum Power” on page 85.
After Securing the Antenna
This chapter describes how to determine the IF drive level that causes 1 dB gain compression of the Block Up-Converter (BUC). This IF level is the “never exceed” level for driving the particular BUC used. The chapter also contains an optional procedure to determine the maximum power with a modulated carrier.

**Note:** The procedures in this section assume that the maximum power in the options file that was loaded on the Satellite Router is set to the highest possible value. If not, it may not be possible to determine the 1 dB compression point and modulated maximum power.

This chapter includes the following sections:
- “Preparation” on page 85
- “Determining the 1 dB Compression Point” on page 87
- “Optional Procedure to Determine PN Max Power” on page 88

### 15.1 Preparation

Determination of the 1 dB compression point (P1dB) is made immediately following successful cross-pol adjustment. The Satellite Router is transmitting a high-level continuous-wave (CW) signal to the satellite, and the respective Cross Polarization windows are open on the local PC user interface. Under direction of the satellite access control center, the Satellite Router transmit IF level is increased until BUC gain compression is detected.

To determine the 1 dB compression point, the access controller must carefully measure incremental power changes at a high resolution. It may be necessary to perform the procedure more than once to be certain that the 1 dB compression point has been properly identified. Follow the direction of the access controller.

The 1 dB compression point is defined as the output power level at which BUC amplifier gain has decreased by 1 dB from the small-signal value. If for example a particular amplifier exhibits a low-power gain of 40 dB, the P1dB point is the output power level at which gain has been reduced to 39 dB. See Figure 49 for an illustration of the concept using sample data representing a typical solid-state amplifier.

Although the P1dB point is located beyond the start of gain compression and is therefore in the non-linear region of the transfer characteristic, most BUCs can operate safely at that power level without exceeding the limits imposed by the transmit spectral mask. Many of
today’s BUCs are able to maintain acceptable Adjacent Channel Power Ratios (ACPR) while operating within a dB or less of maximum rated power.

Network designers consult manufacturer data sheets to determine the operating point and headroom requirements of individual amplifiers. The considerations are incorporated into the link budget and site provisioning calculations. The purpose of P1dB determination in the iDirect system is to set a maximum IF transmit power limit for each site.

Figure 49. Sample Transfer Characteristic
Determining the 1 dB Compression Point

Perform the 1 dB Compression Point test using the same CW carrier used during the cross polarization test. This test determines the point at which the Satellite Router’s transmit power saturates the BUC.

If using iSite, perform this procedure in the Adjust Transmit Power section of the Cross Polarization dialog box. If using Web iSite, perform this procedure in the Transmit Power section of the Cross Polarization page. Both options are shown in Figure 50.

**WARNING!** To avoid over driving the satellite, the BUC and antenna must be sized correctly for the network.

To Determine the 1 dB Compression Point:

1. With the access controller observing the transmitted CW signal, increase the Transmit Power in iSite or Web iSite by 1 dBm.

   **WARNING!** If no power increase is observed, the BUC may already be saturated. Although this is unusual, it can occur. Reduce power and try again.

2. If a 1 dB increase in power is observed, increase the Transmit Power by another 1 dBm.

3. Repeat Step 2 until the observed power increase is less than 1 dB.

4. Subtract the observed power increase from 1. For example, if power increased by 0.8 dB, the difference is 0.2 dB. Record the difference as “delta.”

5. Increase the Transmit Power by 1 dBm. Confirm that the observed power increase is again less than 1 dB from the previous value. Add the difference from 1 to the delta recorded in Step 4.

6. Repeat Step 5 until the sum of all differences (delta) is equal to 1.

7. Record the Transmit Power setting of the Satellite Router at the point at which delta equals 1. This is the 1 dB compression point. The Network Operator will enter this value later as the Maximum Power for the remote site in iBuilder.
8. Click the Stop button in iSite or Web iSite to turn off the CW carrier.

**Note:** Do not re-start or remove power from the Satellite Router.

The 1 dB compression point has now been established. Either perform the optional procedure in next section or disconnect the access control center from the call and proceed to “Acquiring the Network” on page 91.

### 15.3 Optional Procedure to Determine PN Max Power

The optional procedure in this section determines the maximum transmit power of the Satellite Router using a modulated pseudo-noise code (PN) test carrier. The result of this procedure is entered by the Network Operator as a remote custom key. When the custom key is present, this setting is used instead of the configured iBuilder Maximum Power to limit the Satellite Router transmit power during normal operation. There are a number of benefits of executing this procedure and configuring the custom key.

Newer low-cost BUCs use quasi-linear final stage amplifiers (Class AB) to improve DC power consumption and to keep the BUC form factor to a minimum. These BUCs compress a CW tone much earlier than a modulated carrier. There can be as much as 3 dB difference in maximum EIRP when the maximum power is determined using a modulated PN carrier versus a CW carrier. This discrepancy is mainly due to the crest factor difference in the waveforms that results in shifting the bias point of the amplifier. Linear BUCs do not exhibit this characteristic, making the EIRP difference for those BUCs less significant.

Adaptive TDMA reduces the need to provision VSAT terminals with large rain fade margins. This improves throughput in clear sky conditions. Since a terminal so provisioned operates very near its maximum output power under most conditions, proper determination of maximum power is extremely important in an Adaptive TDMA system.

The maximum power must be configured such that the levels do not exceed the target Adjacent Channel Interference (ACI). The procedure defines maximum power to be the power which meets the maximum Adjacent Channel Power Ratio (ACPR) limit permitted by the spacecraft operator for the modulated carrier. The acceptable ACPR varies depending upon the particular spectral mask definition, which in turn varies by signal type, transponder, and spacecraft operator. This procedure generates a BPSK PN sequence. The default Symbol Rate of 128 ksps should be used for this procedure. This carrier configuration produces a worst-case ACPR compared to all other MODCODs and symbol rates supported in iDirect networks.

**Note:** This procedure assumes the acceptable side lobe level is -20 dBc.

**Note:** This procedure assumes that the maximum power configured on the Satellite Router is set to the highest possible value. The maximum values are: 0 dBm for X1 or e150 Satellite Routers; +5 dBm for all other Satellite Routers.

To Determine Maximum Power:

1. After performing the P1dB compression test, ask the access controller for permission to radiate a modulated carrier. The test carrier requires 154 kHz of satellite bandwidth.

2. Advise the access controller to configure the spectrum analyzer as follows:
   - Resolution BW: < 8 kHz
   - Span: 800 kHz
   - Vertical scale: 2 dB/div
Optional Procedure to Determine PN Max Power

3. Start the Transmit Power at the CW P1dB power level. (Refer to Figure 50 on page 87.)

4. Wait until the access controller is ready.

5. If using iSite:
   a. Click Start Modulated in the Cross Polarization dialog box to open the Specify Modulated Carrier dialog box.
   b. In the Specify Modulated Carrier dialog box (Figure 51), accept the default Symbol Rate of 128 kilosymbols per second.
   c. Click OK to transmit the modulated carrier.

6. If using Web iSite:
   a. In the Modulation field of the Modulator section, select BPSK (Figure 52).
   b. Accept the default Symbol Rate of 128 kilosymbols per second.
   c. Click Start to transmit the modulated carrier.

7. While the access controller observes the spectrum analyzer, increase power in 1 dB increments.

8. After each 1 dB power increase, have the access controller clear the averaging mode set in Step 2 and restart averaging.
9. Continue to increase power in 1 dB units. Stop when one of the following occurs:
   a. The total change in observed signal level is 1 dB less than the total change in transmit level
   b. The difference between the main lobe and the side lobes becomes less than 20 dB
   c. The total increase from the CW P1dB exceeds 6 dB and neither of the above conditions is observed

Note: If the total increase from the CW P1dB is greater than 3 dB, ensure that the CW P1dB was determined correctly in “Determining the 1 dB Compression Point” on page 87.

10. Record the Transmit Power setting at which one of the conditions in Step 9 occurred. The Network Operator will enter this value as a custom key when setting the powers in iBuilder after initial acquisition. (See “Setting TDMA Initial Power and Maximum Power” on page 101.)

Disconnect the access control center from the call and proceed to “Acquiring the Network” on page 91.
16 Acquiring the Network

This chapter describes initial acquisition of the Satellite Router into the satellite network. The chapter also provides tables that correlate Satellite Router LED indications with the associated operational states.

This chapter includes the following sections:

- “Initial Acquisition: Overview” on page 91
- “Initial Acquisition” on page 92
- “Front-Panel LEDs” on page 94

16.1 Initial Acquisition: Overview

After executing a restart, the Satellite Router performs a power-on self-test (POST) and acquires the network. Restarting causes the Satellite Router to conform to the operational state defined in the options file, including transmit frequency and initial power settings.

Upon completion of POST, the Satellite Router tunes to and locks on the downstream carrier, which contains an invitation to join the network in the form of acquisition slot assignments on the upstream carriers. The Satellite Router transmits one or more acquisition bursts to facilitate synchronization and allow the Satellite Router to join the network and begin transmitting traffic bursts.

The first acquisition bursts from a newly-commissioned site are transmitted at the power level specified in the options file. This “first burst” power level is determined by the Network Operator when configuring the site in iBuilder.

The initial acquisition or “first burst” power may or may not be sufficient for reliable acquisition. iDirect recommends that the initial power in the commissioning options file be set at a low value (for example, -30 dBm for an X1 or -35 dBm for all other model types) to ensure that the satellite router does not cause interference on the transponder when transmitting its first acquisition bursts. The procedure for bringing the Satellite Router into the network for the first time is described in “Initial Acquisition” on page 92.

After the Satellite Router has been acquired into the network for the first time, the Network Operator must set two power parameters in iBuilder: the maximum site power, and the power to be used for future acquisition bursts, referred to as the initial transmit power. The procedures for setting these parameters are contained in “Setting Power” on page 99.

Note: The initial transmit power must be determined under clear sky conditions.
16.2 Initial Acquisition

Following establishment of the P1dB Compression point, the Satellite Router is powered on and the receive IF cable is disconnected. Perform the following procedures under clear sky conditions to acquire the network for the first time.

Note: In a TRANSEC network, the Network Operator must Disable Authentication for the Satellite Router on the iBuilder Remote→Information tab and apply the hub-side configuration. See “Using the iDirect CA Foundry” in the iBuilder User Guide.

To Prepare to Acquire the Network:

1. Remove power from the Satellite Router.
2. Reconnect the receive IF cable from the LNB to the RX In port.
3. Reconnect power to the Satellite Router.
4. Monitor the Satellite Router LEDs to observe progress and confirm that the Satellite Router’s receiver has locked to the outbound carrier. (See the LED tables in “Front-Panel LEDs” on page 94.)

Depending on the initial power setting in the options file, the Satellite Router may or may not join the network. In either case, the Network Operator should follow the steps below to bring the Satellite Router into the network (if necessary) and to determine the clear sky operating power of Satellite Router. During this procedure, the local installer should monitor the Satellite Router acquisition status as the Network Operator adjusts power.

To Acquire the Network and Determine the Clear Sky Transmit Power:

1. Log in to iMonitor.
2. In the iMonitor Tree, expand the Inroute Group containing this Satellite Router.
3. Right-click the Satellite Router in the iMonitor Tree and select Probe from the menu.
4. In the Remote Power section of the Probe dialog box, click Change to open the Change Remote Tx Power dialog box (Figure 53).

![Figure 53. iMonitor Probe: Changing the Satellite Router Transmit Power]
Note: For TDMA remotes, the Transmit Power displayed in the Remote Power section of the Probe represents the Satellite Router’s transmit power relative to the reference carrier when the remote is in the network. This value is unknown until the Satellite Router joins the network and sends status to the NMS.

5. Ask the local installer to monitor the Satellite Router front-panel LED or Web iSite status indicators to determine when the remote has joined the network. (See “Front-Panel LEDs” on page 94.)

6. In the Change Remote Tx Power dialog box (Figure 53 on page 92):
   a. In Set New Tx Power, enter the minimum transmit power for the Satellite Router, or enter a value several dBm below the value specified in the network link budget for this Satellite Router.

   Note: The minimum transmit power of most Satellite Routers is -35 dBm. The minimum transmit power of an X1 Satellite Router is -30 dBm.

   b. Click Set.

   c. Slowly increase the transmit power by increments of 1 dB and click Set until the remote joins the network.

   Note: When the Satellite Router joins the network, the Transmit Power in the Remote Power section of the Probe will begin to update. However, there may be a delay of several seconds before the value is reported to the NMS. The Satellite Router LEDs provide a more timely indication of when the remote has acquired.

7. Wait for the Transmit Power displayed on the Probe to settle on a constant value and note the value. This value is required to set the correct Initial Power in iBuilder in “Setting Power” on page 101.
16.3 Front-Panel LEDs

Each Satellite Router features a number of front-panel LEDs that indicate acquisition and network status. The installer or site operator can determine the state of the Satellite Router by observing the LEDs and referring to the tables presented in this section.

16.3.1 Evolution e8350

Table 7 contains LED definitions for the Evolution e8350 Satellite Routers:

<table>
<thead>
<tr>
<th>Label</th>
<th>Color</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER</td>
<td>Off</td>
<td>No power or low power input</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Valid power input detected</td>
</tr>
<tr>
<td>STATUS</td>
<td>Off</td>
<td>Power OFF, or executing DRAM test</td>
</tr>
<tr>
<td></td>
<td>Flashing Green</td>
<td>DRAM test failed</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Normal operation</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Fault: software, hardware, or configuration</td>
</tr>
<tr>
<td>NET</td>
<td>Off</td>
<td>Satellite Router off or in sleep mode if TX is yellow</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Demodulator not locked to the downstream carrier</td>
</tr>
<tr>
<td></td>
<td>Flashing Yellow</td>
<td>Demodulator locked. NCR not locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (2 sec)</td>
<td>Demodulator locked. NCR locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (1 sec)</td>
<td>Network acquisition and authentication in progress</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Satellite Router is in the network</td>
</tr>
<tr>
<td>TX</td>
<td>Off</td>
<td>Transmitter off. If STATUS is green, transmitter configured off.</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Transmitter enabled and muted</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Transmitter enabled and not muted</td>
</tr>
<tr>
<td>RX</td>
<td>Off</td>
<td>Receiver off or not configured</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Demodulator not locked to the downstream carrier</td>
</tr>
<tr>
<td></td>
<td>Flashing Yellow</td>
<td>Demodulator locked. NCR not locked.</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Demodulator locked. NCR locked.</td>
</tr>
<tr>
<td>CRYPTO</td>
<td>Off</td>
<td>FIPS mode not enabled</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>FIPS mode enabled</td>
</tr>
<tr>
<td>FAN</td>
<td>Off</td>
<td>No fan alarm</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Fan alarm detected</td>
</tr>
<tr>
<td>TEMP</td>
<td>Off</td>
<td>Normal operating temperature</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Operating temperature near over-temperature threshold</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Operating temperature exceeds over-temperature threshold</td>
</tr>
</tbody>
</table>
16.3.2 Evolution X3 and X5

Table 8 contains LED definitions for the Evolution X3 and X5 Satellite Routers:

Table 8. iDirect Evolution X3 and X5 LED Definitions

<table>
<thead>
<tr>
<th>Label</th>
<th>Color</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>RX</td>
<td>Off</td>
<td>Receiver off or not configured</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Demodulator not locked to the downstream carrier</td>
</tr>
<tr>
<td></td>
<td>Flashing Yellow</td>
<td>Demodulator locked. NCR not locked.</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Demodulator locked. NCR locked.</td>
</tr>
<tr>
<td>TX</td>
<td>Off</td>
<td>Transmitter off. If STATUS is green, transmitter configured off.</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Transmitter enabled and muted</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Transmitter enabled and not muted</td>
</tr>
<tr>
<td>NET</td>
<td>Off</td>
<td>Satellite Router off or in sleep mode if TX is yellow</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Demodulator not locked to the downstream carrier</td>
</tr>
<tr>
<td></td>
<td>Flashing Yellow</td>
<td>Demodulator locked. NCR not locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (2 sec)</td>
<td>Demodulator locked. NCR locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (1 sec)</td>
<td>Network acquisition in progress</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Satellite Router is in the network</td>
</tr>
<tr>
<td>STATUS</td>
<td>Off</td>
<td>Power off, or executing DRAM test</td>
</tr>
<tr>
<td></td>
<td>Flashing Green</td>
<td>DRAM test failed</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Normal operation</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Fault: software, hardware, configuration, or self-test</td>
</tr>
<tr>
<td>POWER</td>
<td>Off</td>
<td>No power or low power input</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Valid power input detected</td>
</tr>
</tbody>
</table>
16.3.3 Evolution X1

Table 9 contains LED definitions for the Evolution X1 Satellite Routers.

**Note:** Evolution X1 Outdoor Satellite Routers have only one LED (POWER) on the front panel. However, the LEDs in Table 9 are simulated by the Web iSite user interface. Log in to Web iSite to view the status indicators.

Table 9. iDirect Evolution X1 LED Definitions

<table>
<thead>
<tr>
<th>Label</th>
<th>Color</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>RX</td>
<td>Off</td>
<td>Receiver off or not configured</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Demodulator not locked to the downstream carrier</td>
</tr>
<tr>
<td></td>
<td>Flashing Yellow</td>
<td>Demodulator locked. NCR not locked.</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Demodulator locked. NCR locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (1 sec)</td>
<td>DRAM test failed (TX and NET also flashing green)</td>
</tr>
<tr>
<td></td>
<td>Flashing Red</td>
<td>All LEDs flashing red: software exception or bad options file</td>
</tr>
<tr>
<td>TX</td>
<td>Off</td>
<td>Transmitter off.</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Transmitter enabled and muted</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Transmitter enabled and not muted</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (1 sec)</td>
<td>DRAM test failed (RX and NET also flashing green)</td>
</tr>
<tr>
<td></td>
<td>Flashing Red</td>
<td>All LEDs flashing red: software exception or bad options file</td>
</tr>
<tr>
<td>NET</td>
<td>Off</td>
<td>Satellite Router off or in sleep mode if TX is yellow</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Demodulator not locked to the downstream carrier</td>
</tr>
<tr>
<td></td>
<td>Flashing Yellow</td>
<td>Demodulator locked. NCR not locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (2 sec)</td>
<td>Demodulator locked. NCR locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (1 sec)</td>
<td>Network acquisition in progress</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (1 sec)</td>
<td>DRAM test failed (RX and TX also flashing green)</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Satellite Router is in the network</td>
</tr>
<tr>
<td></td>
<td>Flashing Red</td>
<td>All LEDs flashing red: software exception or bad options file</td>
</tr>
<tr>
<td>POWER</td>
<td>Off</td>
<td>No power or low power input</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Valid power input detected</td>
</tr>
<tr>
<td></td>
<td>Flashing Red</td>
<td>All LEDs flashing red: software exception or bad options file</td>
</tr>
</tbody>
</table>
16.3.4 Evolution X7

Table 10 contains LED definitions for the Evolution X7 Satellite Routers.

<table>
<thead>
<tr>
<th>Label</th>
<th>Color</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER</td>
<td>Off</td>
<td>No power or low power input</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Valid power input detected</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Incorrect BUC voltage selection</td>
</tr>
<tr>
<td>STATUS</td>
<td>Off</td>
<td>Power off or executing initial self-test</td>
</tr>
<tr>
<td></td>
<td>Flashing Green</td>
<td>Self-test failed</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Normal operation</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Fault: software, hardware, configuration, or self-test</td>
</tr>
<tr>
<td>FAN</td>
<td>Green</td>
<td>All fans working</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Failure of one or more fans</td>
</tr>
<tr>
<td>TEMP</td>
<td>Off</td>
<td>Satellite Router off, or initializing if STATUS is not green</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Normal operating temperature</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Operating temperature near high or low threshold</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Operating temperature exceeds high or low threshold</td>
</tr>
<tr>
<td>RX1/RX2</td>
<td>Off</td>
<td>Receiver off or not configured. (RX2 not supported in iDX 3.3)</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Demodulator not locked to the downstream carrier</td>
</tr>
<tr>
<td></td>
<td>Flashing Yellow</td>
<td>Demodulator locked. NCR not locked.</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Demodulator locked. NCR locked.</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Operating temperature exceeds high or low threshold</td>
</tr>
<tr>
<td>TX</td>
<td>Off</td>
<td>Transmitter off. If STATUS is green, transmitter configured off.</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Transmitter enabled and muted</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Transmitter enabled and not muted</td>
</tr>
<tr>
<td>NET</td>
<td>Off</td>
<td>Satellite Router off or in sleep mode if TX is yellow</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>Demodulator not locked to the downstream carrier</td>
</tr>
<tr>
<td></td>
<td>Flashing Yellow</td>
<td>Demodulator locked. NCR not locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (2 sec)</td>
<td>Demodulator locked. NCR locked.</td>
</tr>
<tr>
<td></td>
<td>Flashing Green (1 sec)</td>
<td>Network acquisition in progress</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Satellite Router is in the network</td>
</tr>
</tbody>
</table>

**Note:** LED indications and definitions are software-controlled, and may differ from previous iDX releases. The definitions in this chapter apply to iDX Release 3.3.
Chapter 17: Setting Power

This chapter describes how to set initial acquisition power and maximum transmit power for the remote site in iBuilder. These procedures are performed by the Network Operator.

This chapter includes the following sections:

- “Overview” on page 99
- “Setting Power” on page 101

17.1 Overview

Remote site transmit power is controlled by the hub Protocol Processor Uplink Control Process (UCP). UCP operates in a manner similar to other uplink power control systems, in that received signal strength is compared to a nominal value, and adjustments are made based upon the comparison. The UCP constantly measures performance and adjusts power as needed. See the iDirect Technical Reference Guide for details.

The power of acquisition bursts transmitted by the Satellite Router must be set as a constant since during acquisition the Satellite Router is not yet participating in the UCP loop. An acquisition or “initial” power must be configured that guarantees acquisition without overpowering the transponder or the receiver. iDirect defines initial power as the acquisition burst power. Initial power varies from site to site.

A separate quantity, referred to as maximum power, is the “never exceed” IF output power for the site. Maximum transmit power also varies from site to site. UCP enforces this limit, and uses the configured value to determine the available power headroom at each site.

After the 1 dB compression point has been determined, the Network Operator enters the initial and maximum power settings for the remote site in iBuilder. Immediately afterward, the Network Operator generates a new options file containing the updated information and sends it to the Satellite Router over the air.

17.1.1 The Reference Carrier

In an Adaptive TDMA network, the upstream transmission can change frequency, MODCOD, symbol rate and/or spreading factor at any time depending upon network demand, rain fade, or other rules. To provide a constant baseline for comparison, a reference carrier is defined for each remote site by the Network Operator. Reference carrier properties are set by the Network Operator on the Remote Information tab in iBuilder. For TDMA remotes, the initial transmit power is configured in relation to the Reference Carrier.
After the Satellite Router has been acquired for the first time and the UCP process is operating, the Network Operator records the reference carrier power level as a clear-sky benchmark for the remote site. The Transmit Power Relative to the Reference Carrier is the Satellite Router IF output power that would be used if the remote site were to close the link at the required C/N_{0} using a carrier with properties identical to those defined for the reference carrier.

The Transmit Power Relative to the Reference Carrier is displayed on the iMonitor Probe screen. The Network Operator notes the transmit power level after acquisition and uses it as the starting point for determining the initial power setting in iBuilder. The procedure for bringing the remote into the network for the first time and determining the transmit power level is contained in “Initial Acquisition” on page 92.

Figure 54 shows the related sections of the iMonitor Probe (left) and the iBuilder Remote Information tab (right) after commissioning. In the figure, the Satellite Router is in the network and is currently transmitting (under UCP control) at -21.78 dBm relative to the configured reference carrier. The Satellite Router sends acquisition bursts at -20 dBm when trying to acquire on a carrier that matches the reference carrier. When acquiring on a carrier with a different configuration, the Satellite Router automatically adjusts the transmit power of the acquisition burst such that it is received by the hub at the correct C/N_{0}.

![Figure 54. Initial Power in Probe and iBuilder](image)

### 17.1.2 Maximum Power

For each remote site, there is an absolute upper power limit imposed by the limitations of the RF amplifier or BUC. For each BUC, there is also an upper limit of usable power imposed by the linearity characteristics of the amplifier itself, in conjunction with the minimum spectral purity requirements for the output signal.

Setting the maximum power in iBuilder has two purposes: to ensure that the remote site BUC is not driven so far into the non-linear region that unacceptable levels of spectral regrowth occur; and to establish a reference point for the Uplink Control Process to determine the usable power headroom available at the remote site at any given time.

The data needed to set maximum power on the iBuilder Remote Information tab was obtained during the procedure executed in “Determining the 1 dB Compression Point” on page 87. The procedure in “Optional Procedure to Determine PN Max Power” on page 88 may provide a more accurate maximum power during network operation. If that procedure was also performed, the resulting value is added to iBuilder as a remote-side custom key.
17.2 Setting Power

After completing the steps in “Acquiring the Network” on page 91, the Satellite Router is acquired into the network and the Protocol Processor UCP loop is controlling power.

17.2.1 Setting TDMA Initial Power and Maximum Power

Use the following procedure to set initial and maximum power for TDMA remote sites.

**WARNING! Setting initial power too high above normal operating levels can cause problems with remote acquisition into the network or interfere with network operation.**

To Set Initial and Maximum Power (TDMA):

1. Log in to iBuilder.
2. Right-click the remote in the iBuilder Tree and select **Modify** → **Item** to open the Remote Information tab.
3. Scroll down to the **Transmit Properties** section (Figure 55).

![Figure 55. iBuilder Transmit Properties: TDMA](image)

4. In the **Reference Carrier** section, set **TDMA Initial Power** to the Transmit Power recorded in Step 7 of “Initial Acquisition” on page 92 plus any link budget margin required to acquire the network under all conditions.
5. In the **Transmit Properties** section, set **TDMA Max Power** to the (CW) P1dB point determined in “Determining the 1 dB Compression Point” on page 87.
6. Enter the same value in the **1 dB Compression Point** field. (This is an optional field for information only).
7. If the procedure “Optional Procedure to Determine PN Max Power” on page 88 was performed:
   a. Click the Remote Custom tab.
   b. Enter the following Remote-Side custom key:

   \[ \text{max\_power\_level\_in\_db\_pn} = \text{<Modulated Max Power>} \]

   where \text{<Modulated Max Power>} is the maximum power determined in “Optional Procedure to Determine PN Max Power” on page 88. This is illustrated in Figure 56.

![Figure 56. Setting Modulated Maximum Power Custom Key](image)

8. Click OK to save the changes.

9. Right-click the remote in the iBuilder Tree and select Apply Configuration→Reliable Both (TCP).

   If commissioning a remote in a TRANSEC network and authentication has been disabled, perform the following steps:

   1. If the remote has not yet been issued an X.509 certificate, issue the certificate now. (See the iBuilder User Guide appendix “Using the iDirect CA Foundry” for details.)
   2. Re-enable authentication on the remote Information tab by clearing the Disable Authentication check box.
   3. Click OK to save the changes.
   4. Right-click the remote in the iBuilder Tree and select Apply Configuration→Reliable Both (TCP).
17.2.2 Setting SCPC Return Initial Power and Maximum Power

The following procedure sets the initial and maximum power for a Satellite Router that transmit an SCPC return channel.

To Set Initial and Maximum Power (SCPC Return):

1. Right-click the remote in the iBuilder Tree and select Modify→Item to open the Remote Information tab.
2. Scroll down to the Transmit Properties section (Figure 57).

![Figure 57. iBuilder Transmit Properties: SCPC Return](image)

3. In the 1 dB Compression Point field, enter the value for (CW) P1dB point determined in Step 7 on page 87. (This is for information only).
4. Click Edit SCPC Initial Power to open the SCPC Initial Power dialog box (Figure 58).

![Figure 58. iBuilder Transmit Properties: SCPC Initial Power](image)

5. In the SCPC Initial Power dialog box, double-click the cell in the Initial Power column of the applicable SCPC return carrier. Enter the transmit power recorded in Step 7 of “Initial Acquisition” on page 92 plus any link budget margin required to acquire the network under all conditions.
6. Double-click the cell in the Max Power column of the applicable SCPC return carrier. Enter the value determined in “Maximum Power” on page 100.
7. Click OK in the SCPC Initial Power dialog box to return to the Remote Information tab.
8. Click **OK** to save the changes.

9. Right-click the remote in the iBuilder Tree and select **Apply Configuration**→**Reliable Both (TCP)**.

**Note:** In iBuilder, separate Max Power and Initial Power values can be configured for multiple SCPC upstream carriers per remote to facilitate switching the remote from one SCPC return channel to another. If the remote will be transmitting more than one SCPC return channel, repeat the previous procedure for each SCPC carrier. The Initial Power may vary per carrier depending on a number of factors, including satellite transponder response, symbol rate, MODCOD, and block size.

After completion of the procedures in this chapter, continue to “Post Acquisition Activities” on page 105.
18 Post Acquisition Activities

To ensure trouble-free operation, certain activities must be completed after the Satellite Router is acquired into the network for the first time. Some of the activities are performed by the Network Operator. Other activities are performed by the remote installer.

This chapter includes the following sections:

- “Network Operator Duties” on page 105
- “Remote Installer Duties” on page 105
- “Initiating Traffic Flow” on page 108

18.1 Network Operator Duties

After the Satellite Router has acquired into the network for the first time, the Network Operator takes control of the Satellite Router to perform the tasks described in this section.

**WARNING! Do not remove power from the Satellite Router during these procedures.**

1. Follow the procedures in “Setting Power” on page 99 to set initial and maximum transmit power.
2. If the installation is for an uncertified Satellite Router in a TRANSEC network, issue an X.509 certificate and enable authentication on the Remote Information tab in iBuilder.
3. Download the updated configuration to the Satellite Router and reset the remote over the satellite link.
4. Record levels of the Satellite Router as a baseline for troubleshooting.
5. Verify that the software and firmware on the Satellite Router are at the correct revision level. If necessary, upgrade the software on the Satellite Router and reset the remote.
6. Inform the remote installer when all tasks are complete.

18.2 Remote Installer Duties

After the Network Operator has made any additional adjustments to the Satellite Router configuration, the Satellite Router is reset. Upon completion of POST, the Satellite Router acquires the network for the first time in the fully operational state.
Remote Installer Duties

After acquisition, record the baseline readings as outlined below. The data serves as a reference in case the antenna is moved or some other service issue arises.

Baseline readings are checked periodically by the Network Operator to ensure that the service is not degrading. Many events such as bad weather, sand or dust storms, solar flares, movement of the antenna, or aging can cause the levels to change. For transient events, monitor the levels to confirm return to the baseline values.

Follow the procedure in “Recording Remote Status Using a Console Connection” to record the baseline readings for all model types except for Evolution X1, X7, and e150 Satellite Routers. For those models, follow the procedure in “Recording Remote Status Using Web iSite” on page 107.

18.2.1 Recording Remote Status Using a Console Connection

Follow the steps in this section if commissioning an Evolution X3, X5, e8350, or e8xx Satellite Router.

To Display Remote Status Messages:

1. Telnet to the Satellite Router or open a terminal session to the Satellite Router. See “Connecting to the Console Port” on page 17 for details, including default passwords.
2. Log in as root and telnet localhost to the admin account.
3. At the prompt, enter the rmtstat command. The command toggles Status Message printing On or OFF. Confirm that the return message is “Printing Remote Status messages is ON”. See Figure 59.

![Figure 59. Remote Status Message](image)

4. Wait for Remote Status: to display. The message updates periodically. Record the following data from the remote status message:
   a. SNR (Signal-to-Noise ratio of downstream carrier)
   b. TxPower (IF output power in dBm)
   c. RxSignalPower (Total composite input power seen by the receiver)
   d. Temp (Operating temperature in degrees Celsius)

5. Report the readings to the Network Operator, and save locally for future reference
18.2.2 Recording Remote Status Using Web iSite

Follow the steps in this section to record remote status for Evolution X1, X7, and e150 Satellite Routers.

To Display Status:

1. Open a Web browser and log in to the Satellite Router as either user or admin. (See “IP Address” on page 41 for details).

2. In the navigation bar at the top of the Web iSite window, click the Status button. The Modem Status page appears by default. If not, click the Modem Status link on the left. See Figure 60.

![Figure 60. Web iSite Modem Status Page](image-url)
3. Scroll down as needed to view and record the following data on the Modem Status page:
   a. Temperature (under Modem State)
   b. Rx Composite Power (under Rx State)
   c. Rx SNR (under Rx State)
   d. Tx Power (under Tx State)


18.3 Initiating Traffic Flow

Following completion of the procedures in this and previous chapters, the Satellite Router is ready to carry user traffic. If the IP connections to the LAN port(s) have not been made, do so now. Test the circuit by initiating IP traffic over the LAN.

Testing of IP throughput is not generally considered a commissioning activity, and is beyond the scope of this guide. Refer to the iDX Technical Reference Guide for information about IP throughput scenarios.
Appendix A: Loading Images with TFTP Server

An alternate method of downloading the images to the Satellite Router is to use the TFTP server that comes bundled with iSite.

Note: This appendix is not applicable to Evolution X1, X7, or e150 Satellite Routers.

1. Open iSite and select TFTP from the File menu.
2. Select the TFTP server local folder in the pop-up window. Browse and select the folder in which the remote package resides.
3. Telnet to the Satellite Router or open a console session using the procedure “Connecting to the Console Port” on page 17.
4. Log in as root.
5. Enter service indirect_falcon stop. This will stop the iDirect application.
6. Enter tftp_package.sh <IP address of TFTP server> <package name>.
   For example, if your laptop’s IP address is 10.10.1.2 and you are loading 9.0.0.4 remote package the command will be tftp_package.sh 10.10.1.2 remote 9_0_0_4.pkg.
7. Once the transfer is complete, reset the remote using the reboot command.
Appendix B: Disabling the PWM Voltage in iBuilder

The PWM voltage normally present on the TX Out port during antenna pointing may be disabled from within iBuilder.

To Disable the PWM Voltage:
1. Apply power to the Satellite Router and allow it to initialize.
2. In iBuilder, right-click the remote and select Modify→Item.

The Remote Information tab opens.

Figure 61. iBuilder Remote Information Tab: Disabling Tx PWM
Disabling the PWM Voltage in iBuilder

3. On the Remote Information tab, select Disable Tx PWM if it is not already selected.
4. Apply the new configuration and reset the Satellite Router.